
Welcome to HotDog

No more “Mr Nice guy”.      The green dog’s back after months of workin’ hard at the gym. Sick and tired of 
being pushed around by the 16bit HTML editor crowd……HotDog is BACK and flexing those 32bit 
muscles!!! 

Introduction to HotDog
Contact Sausage Software 



// THIS IS THE NEW HOTDOG32 HELP STUFF

// DATE 240496 Start

// DATE 250496 Release Beta 0.9

// DATE 010596 Release 1.0

// DATE 070596 Release 1.1

// DATE 140596 Major revamp of structure/content

// DATE 160596 Created HTML Book

// DATE 180596 Structure & Contact Book

// DATE 210596 Worked on structure, 

// DATE 210596 Created links to new books.

// DATE 220596 Worked out how to do indexing.

// DATE 220596 Worked on backbone of Menubar

// DATE 220596 File menu

// DATE 230596 Edit menu

//DATE 270596 View Menu

//DATE 280596 Extra stuff along the side of Menu

//DATE 290596 Help, Toolbars & Char BOOK

//DATE 300596 Toolbars, Windows & Characters

//DATE 310596 Menus, tags & where is this stuff!



// DATE 030696 Tags

// DATE 040696 Tags, clean-up & prep for Brian.

//DATE 050696 Tools, Insert & Format structure

//DATE 060696 Format    completed

//DATE 110696 INSERT STARTED

//DATE 130696 Insert continued

//DATE 140696 Insert cont.

//DATE 170696 Insert cont.

//DATE 180696 Insert cont. Finish today

//DATE 190696 Options start



Introduction to HotDog

Welcome to HotDog, the easy and powerful way to create pages for the World Wide Web (WWW) . 
The HotDog Web Editor helps you design pages for the World Wide Web (WWW). Web pages are 
written in HyperText Markup Language (HTML), a text-based language. Browsers like Netscape 
and Mosaic read the HTML files, and display them on the screen. The difference between an HTML 
document and a word processing document is that the same HTML document can be read on many 
different computer platforms, for example PC, Macintosh and UNIX.

Overview of HotDog
Detailed look at HotDog



HotDog Overview

As mentioned previously,    HotDog is a stand-alone program thus it doesn't need an expensive word 
processing program to run.    HotDog offers many ways to making creating HTML documents easier. 
If you are an experienced HTML author, you can type all the formatting tags directly, or make your 
own toolbars.    If you are new to HTML, HotDog has menus to let you do things such as inserting 
images, formatting, and hypertext links into your document without having to learn all the specific 
requirements of HTML. 

What do you want to know about HotDog?
HotDog Pro Vs HotDog Standard
HotDog Features

Latest information for HotDog, Web and HTML related topics,
What’s “New” in HotDog
HotDog resources on the Web
Latest HTML Tags reference

Questions, questions more questions…
What’s a “Hosting service” & why use one? 
The Jargon Buster
Frequently Asked Question



Features found in HotDog

We've put a lot of work into making HotDog easy to use, flexible, powerful, and fun! Here's just some of 
the ways that HotDog makes life easier for you.

1    Background Reality Checker An easy way to let you pick backgrounds and text colors for your 
web pages.

2    Templates:    Create new documents from an unlimited number of custom templates

3    Embedded Fields:    Set fields that are updated when you create, save, or publish documents. 
These fields can prompt the user for information, read it from a file, or automatically calculate 
internal functions like date and time, the HotDog version, the user name, and so on.

4    Shortcut Keys:    Assign any command to any key combination

5    Tags:    Create your own beginning and end tags, or modify the existing ones.

6    Web Projects:    Open and save multiple files with a single mouse click.    Auto-Upload upload the 
current document or an entire web site to the Internet, with a single mouse click.

7    Floating Toolbars:    Create your own floating toolbars.    Allows you to put the tools, tags & text 
that you want onto the desktop.

8    Colored Tags:    Colored Tags - for instant identification of standard and non-standard tags.

9    Supports both Netscape Extensions to HTML, Microsoft Extensions to HTML, and proposed 
HTML 3 elements. Don't be fooled by our competitors, who promise you HTML 3 but only deliver 
Netscape !

10    Windows 95-style interface in Windows 3.1 and Windows NT.

11    Dialogs let you perform complex tasks like creating forms and tables in a few seconds.

12    HotDog saves you time with features like finding duplicate links and converting DOS files for 
use on UNIX systems.

13    Unlike most of our competitors, HotDog gives you a lot of control over how it works. Don't like 
the way HotDog does something?    For example if you check out the Tools Option menu,    you 
can easily set almost 50 options to change how HotDog behaves.

14    HotDog remembers your hypertext links, so you don't need to keep typing long URLs.



15    Insert links, images, and text files by dragging them from File Manager or the internal HotDog 
File Manager.

16    Edit your CGI scripts as well as HTML files.

17    Never lose your work again! HotDog has options for automatically saving your work, and 
creating backup files whenever it saves.

18    Advanced options like translating extended characters into HTML codes, while you're typing!

19    Our publishing feature lets you automatically replace text when your document is ready to 
Preview.    Why type the URL for your home page all the time, when you can type something like 
{home} and let HotDog translate it automatically?

20    Context-sensitive help. Press F1 from any screen to get help on what each part of the screen 
means or does.    You can find which screens have context sensitive help by looking in the menu 
options,    for example the Tools menu options.



HotDog Pro Vs HotDog Standard

The Professional edition of the HotDog Web Editor offers you everything that the Standard one does, 
plus:

1    The Real-time Output Viewer- (ROVER):    See what your web page will look like, while you’re 
working on it

2    Sound Mixing Desk:    Add sound to HotDog functions or commands

3    Check HTML Syntax:    Let HotDog examine your pages for common HTML problems and 
mistakes.

4    Spell checking:    With several different language modules available from our Web site.

5    HTML Converter:    Automatically convert your existing text files into HTML documents



Snaglets “alive” in HotDog. 
It had to happen. “The Snaglets have invaded HotDog”.    You now have the ability to create Java 
animation,    Frames & Client Side Image Maps within HotDog. 

1    Java Animator:      The Java animator brings sound and movement to your Web page.    Supply 
your own images and sound and let the animator do the rest.

2    Client Side Image Maps:      Image maps let you use define an area on a graphic that can be 
treated as a hypertext jump.

3    Frames:      Create frames visually without having to have a great understanding of Frame 
HTML.    The Frame tool allows you to create, modify and refine Frames without having to create 
any Frame HTML.

Don’t forget about:
There are some great time saving features so don’t forget to try them out.    The sound mixing desk is 
brand new and major modifications have been made to ROVER so take a look.



< HTML Tags Reference >

The HTML Tags reference has now been compiled into a separate file, Html.hlp.    The foremost 
reason is that the current HTML specification is HTML v3.2.    In the very near future a new Html.hlp 
file will be compiled and found on our Web site covering the new specification.    If you want any 
information about following then read-on.

· HTML v2 specification & tag information
· Netscape enhancements
· Microsoft enhancements
· A quick reference guide to Tags

Latest HTML Tags reference



Latest Information about HotDog

For all the latest release information on HotDog.    It includes stacks of goodies so read-on,
· There’s Major advances
· Enhancements to pre-existing features
· New tools & features
· HotDog resources on the Web
· Evil Kim’s Tech-Support tips
· Programmer Brian’s “POWER USER” tips.

I want to find out what’s New in HotDog



Ordering HotDog

Contacting Sausage Software varies depending on what you want to contact us for!      Check below for 
the various contact routes and select the most appropriate method for you.

I want to contact Sausage Software 



Why Use A Hosting Service?

Naturally, you want everybody on the Internet to be able to look at the pages you've spent so much 
time and effort creating. This means that your web pages have to be on a computer running 24 hours 
a day, with a permanent, high-speed Internet connection. You could do this yourself, but you would 
need to pay for a fast computer, a good web server, a high-speed Net connection, and someone to 
constantly maintain and repair the system. The cost for this can easily exceed $10,000.

Paying someone else to "host" your web pages is a much more cost-effective solution. You rent 
space on someone else's web server, generally for a monthly fee. When your pages are ready to go 
to the Internet, you log onto the server with your FTP program, and upload the files to your own 
personal directory. And that's it! Once the files have been uploaded to the hosting service's computer, 
anyone on the Web can look at your pages, at any time.

The AnaServe (tm) Service
Sausage Software has teamed up with Anawave Software in California to help you get your 
information onto the web. We've put a lot of work into putting the highest possible quality standards in 
our software; rest assured that Anawave will put just as much work into providing you with the best 
quality web hosting service you can get, for an unbeatable price! Anawave's AnaServe (tm) web 
hosting service is only $19.95 per month (plus a $29.95 activation fee), for up to 5Mb of information! 
For more information about AnaServe, read the sign-up contract. 



AnaServe Web Hosting Contract

AnaServe Web Hosting Agreement - Sausage

AnaServe's high speed computers and communication lines provide a fast and
friendly link to worldwide users of the World Wide Web. AnaServe also saves
you the expense of having a dedicated computer, phone line, 24 hour
Internet access, and system administration. And best of all, AnaServe is
fun and easy to use!

The following represents a partial list of AnaServe's features and 
benefits:

We provide each customer with 5 megabytes of disk storage which can be
used for files, text, graphics, sound files, and even video! Additional
disk space can be purchased at an affordable rate.
 

AnaServe has one of the highest basic traffic allowances available (500
megabytes per month), and our rates for high traffic sites are among the
most affordable anywhere. Very few sites exceed the 500 megabyte allowance,
and Anawave will not bill you without prior approval (See the attached
AnaServe "Terms and Conditions" for more details).
 

We allow you to use custom CGI scripts (Perl 4.0 Only) with prior
approval. Our technical support team has a library of basic scripts that
you can include in your web site for a nominal charge. Call 714.250.7263,
Ext. 240, for additional information.
 

We will also assign a unique alias to your account (i.e.,
"www.anawave.com/~yourname"). Or, at your option, we can upgrade
your site with a unique domain name ("UDN"). Your domain name on
the Internet will be ("www.yourname.com"). The UDN service fee
is only $29.95, and it gives you our basic service plan plus a unique
domain name. Investing in a unique domain name for your web site increases
your identity on the Web.
 

As part of your AnaServe subscription, you will receive free and
automated traffic reports of people that have visited your site.
 

AnaServe now supports mail forwarding from your address at
yourname@anawave.com to the e-mail address of your choice.



 

Best of all, Anawave provides free technical support (8:30 a.m. - 5:30
p.m., M-F, PST). Please call 714.250.7263, ext. 240, or 1.800.711.6030
for additional information. 

AnaServe Service Rates:         Personal   Standard   Domain (UDN)
Setup Fee (One Time)             $14.95      $29.95     $149.95*
Monthly Service Fee               $9.95      $19.95      $29.95
Available Disk Space                5MB         5MB         5MB
Cost Per 1 Extra MB/Mo.           $1.95       $1.95       $1.95
Traffic Allowance                 500MB       500MB       500MB
Extra Traffic Allowance(500MB)  $19.95/Mo.  $19.95/Mo.  $19.95/Mo.

* Our $149.95 Setup fee for UDN level service includes the first two
years of registration with the InterNIC. There are no "hidden" charges!
Personal pricing is for non-commercial use only. All rates are subject
to change.

Contact Information

Name _____________________________________________

Title ____________________________________________

Company name _____________________________________

Street ___________________________________________

City _____________________________________________

State_____________________________________________

Zip code__________________________________________

Daytime phone ____________________________________

Fax_______________________________________________

e-mail ___________________________________________

Payment ( ) Visa   ( ) Mastercard  ( ) Other______

Card number ____________________Expiration Date___



Name on card _____________________________________

Computer ( ) Macintosh ( ) IBM-PC ( ) Other ______

Service level o Personal
              o Standard
              o Domain (UND)

If Domain service level, what would you like us to call your web site?
Give us your top 4 choices for a web site name. Rank in your order
of preference.

_______________   _______________   _______________   _______________

Terms and Conditions (Sausage)
This agreement is between Anawave Software, Inc.,
("Anawave") and the Customer (as noted above) to provide World
Wide Web ("Web") access and creative services to the Internet on
Anawave's network of shared server(s).
We accept cash, check, MasterCard or Visa for payment.
All services will be billed within the first week of any given month. Bills
for partial periods are prorated. Anawave reserves the right to change
pricing within the thirty (30) days notice. We bill $1.95 per megabyte of
disk space used by the Customer. Unique domain names(i.e. www.yourname.com)
have a $149.95 activation fee and $29.95 monthly service fee. If the
Customer's data transfer rate exceeds 500 megabytes per month, Anawave
reserves the right to bill Customer an additional $19.95 per 500 megabytes
transferred. Anawave will not, however, bill Customer without 15 days
notice. Customer will then have the option of continued service with the
transfer rate surcharge, or Customer can request that their service be
canceled. 
Unless otherwise noted and agreed upon, in writing by
Anawave, Customer shall use this account to represent only one named
organization or company. Customer may not include material for, or sublease
space for any other individual, business, or organization.
Anawave will provide the hardware and system
administration necessary to provide full World Wide Web access to the
Internet community. Anawave will also provide a single & unique
Universal Resource Locator (URL) address for use by Customer to promote
Customer's page on literature and other Web servers. At Customer's request,
Anawave will assign a single domain alias to our server(s) (i.e.,
www.yourname.com) provided that the name is legally registered to and under
the control of the Customer. Customer understands that Domain Name
Registration can take 4 weeks (or more). Anawave will, however, assign a



temporary name to the Customer's pages (i.e., www.anawave.com/~yourname).
Customer agrees to pay InterNIC renewal fees (currently $50.00/year after
first two years). This fee is subject to change by the InterNIC. Customer
will have 24-hour access to their account on our server via File Transfer
Protocol (FTP). Customer understands and agrees that Anawave will make
every effort to keep our network of server(s) running continuously.
However, our server(s) will, from time to time, be disconnected due to
routine maintenance, upgrades, and other required events.
Anawave will make its best effort to keep all information
on our servers backed-up. However, we recommend that the Customer maintains
a separate back-up of any information posted to our server(s). Anawave is
not responsible for lost materials or information. Customer understands
that all technical support will be given by Anawave, at its option, in the
form of on-line information in the form of FAQ, e-mail, or fax. Anawave
will also make its best effort to maintain security on our network of
server(s). However, the nature of the Web and the Internet is not secure by
default; Customer assumes responsibility for the appropriate use of
hypertext based security within the Customer's scripts and directories.
Perl 4.0 CGI scripts are the only CGI scripts supported by Anawave. All CGI
scripts require prior approval by Anawave.
By signing this agreement, Customer releases Anawave from
any liability that may arise from any business interruption to the
Customer's business resulting from using our services. Anawave is in no way
responsible for the performance of any information posted to our network.
In addition, Customer assumes full responsibility for all content posted to
Anawave's server on Customer's behalf, including any trademark, copyright,
patent or other intellectual property submitted to Anawave for either
creative services and/or straight posting to our server(s). Anawave
reserves the right to remove any material, which, in its sole opinion, may
result in the violation of intellectual property rights of others or any
other applicable Federal, State, Common, International laws or regulations.
In the event that this contract is canceled by Anawave, the Customer will
have a pro-rated refund of any unused portion of the posting period. Domain
registration fees are non-refundable.
Customer acknowledges that these terms and conditions are
subject to change without notice. Customer continued use of AnaServe
constitutes customer acceptance of these and any and all modified
terms.
Terms read and understood 
Authorized Signature and Date ___________________________________
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Work

Why does the menu not work?

040696
Work

Inserted some text descriptions about what’s in detailed look in HotDog!

050696
Work

Moved lists back in-line



A detailed look at HotDog

HotDog is an application chocka-block full of features.      The following pages are a comprehensive 
look at just exactly what’ the Ol’ Dogs capable of.      You have three choices,    go    through the Menus, 
work on some tutorials Tutorials or look for a deeper Explanations.

Menus
Tutorials
Explanations



030696
Work

Should I include a brief description of the menu here???

040696
There is a minimum of info that should be tested & checked

050696
Included HotDog Icon

060696
TEST FILE
    accuracy OK
    spelling Tested
    inclusions what’s this
      NEW                            rover explanation
      SAVE                          document bar check
      SAVE AS              List Of File Types
      PREVIEW DOCUMENT Default browser
                                        What type of browser can I use
                                        Which option to select when it is ???
      PUBLISH DOCUMENT What is publishing options
      OPEN PROJECT          What's a Web project?
      EXIT                          What's Tags List 
                                        What's Char code List



Menus in HotDog

Just about everything that you can possibly do in HotDog can be done through menus and their logically 
grouped menu options.    The menubar is the backbone of HotDog.    It’s a little boring,    and a few 
features require you to access multiple menus. But you don’t have to remember that customized shortcut 
key or button.    If you can’t remember where a certain function or tool is the menubar gives you chance to 
use your deductive powers of reasoning to find it.

Menu Default shortcut
HotDog Icon
File Alt+F
Edit Alt+E
View Alt+V

Insert Alt+I
Tags Alt+T
Toolbars Alt+o
Format Alt+F

Tools Alt+l

Window Alt+W
Help Alt+H



Snaglets



050696
Work    HotDog Icon

Just found this one today
Q should I describe these operations?
Q should I bother to put in the search indexing?



HotDog Icon

When you click the HotDog Icon a pull-down menu of Windows file options appears.    The file 
options relate specifically to the currently opened file.

Take note of the following,
· That the default shortcut letter for each particular option in the HotDog Icon menu can be 

found in the letters column.

Option name Letter Description
Restore R
Move M Move the file around the screen.
Size S Maximize, Minimize.
Minimize n Collapse file to icon.
Maximize x Expand a collapsed file.
Close C Close a file.Will prompt you to save changes.
Next t Selects next file.



File

The File menu option contains all the HotDog operations related to files and file operations.    Take 
note of the following,

· That the default shortcut key for locating the file menu is ALT+F
· That the default shortcut letters for locating a particular option in the File menu is to the 

right of the option name under the letter column.
· That any File menu option marked “Yes” in the dialog box column,    indicates a dialog box.

Option name Ctrl Letter Dialog Box

New Ctrl+N N
Open Ctrl+O O Yes
Save Ctrl+S S
Save As Ctrl+A A Yes
Save All
Close C

Preview Document F10 e Yes
Publish Document Ctrl+U u Yes

Print P
Print Setup i

Open Project Ctrl+P r Yes
Close Project
Project Manager t

Exit Ctrl+Q x
Window List



New

DESCRIPTION:
Opens a new document for editing. The new document will be referred to as "Untitled" in the Document 
Bar.

LOCATION: File New

FEATURE:
HotDog Professional has unlimited file size - HotDog Standard can't handle individual files larger than 
32k. In HotDog Pro, you can use files as large as your available memory will allow.

USAGE TIPS:
1    If you want to use ROVER then you must save your file first.

2  Files greater than 2 Meg  .   



Open

DESCRIPTION:
Open an existing file for editing. The file will appear in its own window, and its name will be listed on the 
Document Bar at the bottom of the screen.

LOCATION: File Open

FEATURE:
1    HotDog will automatically detect UNIX text files. These will be converted to normal text for editing, 

then converted back to UNIX when they are saved.

2    If you want to permanently convert a UNIX file into a Windows text file, use the Save As 
command in the file menu and choose a non-UNIX type (for example HTML file or Text file).

3    Files greater than 2 Meg  .  



Save

DESCRIPTION:
Saves the current document.    If you have not saved the file before,    this option has the same effect as 
choosing Save As from the File menu.

LOCATION: File Save

FEATURES:
By default HotDog forces all file names into lower case (not the directories, just the file itself).    This 
makes it easier when putting web sites from case-insensitive Windows machines to case-sensitive UNIX 
boxes.

USAGE TIPS:
1    When you leave HotDog, you will be asked if you want to save changes to any documents that 

have not been saved since the last alteration. Documents that have not changed are indicated on 
the Documents Bar with the  icon. Unsaved documents are marked with a 

2    If you want to save an existing document under a new name, choose File     SaveAs  .    When you 
save a document, the Most Recent Files list in the File menu will be updated.

3    HotDog automatically recognizes UNIX text files. These will be converted to normal text for 
editing, then converted back to UNIX when they are saved. If you want to permanently convert a 
UNIX file into a Windows text file, use the    File     SaveAs   and choose a non-UNIX type (for 
example HTML file or Text file).



Save As

DESCRIPTION:
Saves the current document with a new name. This can also be used to convert Windows text files to 
UNIX text, or UNIX text files to Windows text. Choose one of the UNIX options in the List Files Of Type 
box to change Windows to UNIX. To convert the other way, choose any option but a UNIX one.

FEATURES:
By default HotDog forces all file names into lower case (not the directories, just the file itself).    This 
makes it easier when putting web sites from case-insensitive Windows machines to case-sensitive UNIX 
boxes.

LOCATION: File SaveAs

FEATURE:
Files greater than 2 Meg.



Save All

DESCRIPTION:
Saves all open documents. If any of these files have not been saved before, this option will have the 
same effect as choosing File SaveAs..

LOCATION: File SaveAll

FEATURES:
By default HotDog forces all file names into lower case (not the directories, just the file itself).    This 
makes it easier when putting web sites from case-insensitive Windows machines to case-sensitive UNIX 
boxes.



Close

DESCRIPTION:
Closes the current document.    If the document has been changed since the last time it was saved, you 
will be asked if you want to save the changes.    Documents that have not changed are indicated on the 
Documents Bar with the  icon.    Unsaved documents are marked with a 

 

LOCATION: File Close



Preview Document

DESCRIPTION:
This option launches the default Browser .    The default browser let’s you see what your Web document 
may look like from a from the users perspective on the Web. 

LOCATION: File PreviewDocument

USAGE TIPS:
1    If you have not told HotDog where to find your Browser, you will be asked to locate it. Choose the 

appropriate program file, for example C:\NETSCAPE \NETSCAPE .EXE.

2  You can change the default Browser at any time from the File Locations section of the Options 
screen.

3  It is a good idea to test your Web documents with as many different browsers as possible. HotDog 
provides an option to let you select which browser you want to use every time you preview. 



Publish Document

DESCRIPTION:
This option will format the current document, ready for uploading to the Internet. It will have exactly the 
same effect as saving the document, unless you have set Publishing Options.

LOCATION: File PublishDocument

USAGE TIPS:
The publishing options let you do things like keep final documents in a separate directory, convert DOS 
file names like hotdog\readme.txt into UNIX file names like hotdog/readme.txt, and replace text with 
"aliases".



Print

DESCRIPTION:
Prints the current document to the default printer.

LOCATION: File Print

USAGE TIPS:
If you print the file it will have the tags around the text.    If you want to print a web document without tags 
then do the following,

· Save the file you want to print.
· Save the file again using another name.
· Select all the text in your web document using,    Edit SelectAll
· Remove all the tags from the selected text using,  Tools RemoveHTMLTags
· Print the file (without tags) using,    File Print
· Exit the file (without tags) and load your original file (with tags).



Print Setup

DESCRIPTION:
This option lets you change the default printer and change the setup of the printer. For example, you can 
choose to print documents in Landscape mode instead of Portrait. 

LOCATION: File    PrintSetup

FEATURE:
Gives access to the Windows printer dialog.    Using this dialog you can change the,

· Printer properties, (Printers available etc.).
· Paper size & Source.
· Paper orientation, (Landscape or portrait.).

USAGE TIPS:
For more information, see the documentation for your printer.



Open Project

DESCRIPTION:
Open Project lets you open a Web Project that you’ve previously created. Web Projects are a 
convenient way to deal with multiple files at the same time.

LOCATION: File OpenProject

FEATURES:
By default HotDog forces all file names into lower case (not the directories, just the file itself).    This 
makes it easier when putting web sites from case-insensitive Windows machines to case-sensitive UNIX 
boxes.

USAGE TIPS:
For example, you can create a project containing five related HTML documents. Every time you 
open the project, all five documents will be loaded into HotDog for editing. Using a project means that 
you only need to open one file (the .PRJ project file) instead of the five individual documents.



Close Project

DESCRIPTION:
Allows you to close the current project you have open.    It is especially useful if you are working on a lot 
of projects and you need to close one project to get to another project quickly.

LOCATION: File CloseProject

FEATURES:
By default HotDog forces all file names into lower case (not the directories, just the file itself).    This 
makes it easier when putting web sites from case-insensitive Windows machines to case-sensitive UNIX 
boxes.

USAGE TIPS:
You can also close the current project by, 

· Moving you cursor to the Window option on the menu bar
· Select close all option
· All currently opened windows will now be closed



Project Manager

DESCRIPTION:
The Project Manager is an easy way to add ,    delete files,    produce a project report    or publish a 
document.    Web Projects are a convenient way to deal with multiple files at the same time. 

LOCATION: File ProjectManager

FEATURES
1    You can    Addto a project.
2    Also produce a Project Report
3    Publish a Document.
4    The project manager allows you to open a subset of the files that make up a project.    But even 

though you haven't loaded them all its still useful to have a list of the other files so that you can 
drag them in as links. 

5    The View menu will have a Project File command that you can call to bring this floating list into 
view.

USAGE TIPS:
For example, you can create a project containing five related HTML documents. Every time you open 
the project, all five documents will be loaded into HotDog for editing. Using a project means that you 
only need to open one file (the .PRJ project file) instead of the five individual documents.



Exit

DESCRIPTION:
Using this option you quit out of HotDog. If any documents have been changed since the last time they 
were saved, you will be asked if you want to save the changes. Documents that have not changed are 
indicated on the Document Bar  with the  icon. Unsaved documents are marked with a 

LOCATION: File Exit

FEATURES:
By default HotDog forces all file names into lower case (not the directories, just the file itself).    This 
makes it easier when putting web sites from case-insensitive Windows machines to case-sensitive UNIX 
boxes.

USAGE TIPS:
1  HotDog will save the size and position of the main window, Tags List, and Character Codes List 

when you leave.

2  If you set the Restore Last Session option, HotDog will also save the size and positions of all 
currently open documents. Next time you start HotDog, these will be restored.
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Edit

The Edit menu option contains all the HotDog operations related to editing.    This includes text 
editing with files, tags and also includes some edit related tasks.    Take note of the following,

· That the default shortcut key for locating the Edit menu is ALT+E
· That the default shortcut letter for locating a particular option in the Edit menu are to the 

right of the option name.
· That any Edit menu option marked “Yes” in the dialog box column indicates an associated 

dialog box.

Option name Ctrl Letter Dialog Box
Undo U
Cut t
Copy C
Paste P
Append A
Find Ctrl+F F Yes
Replace Ctrl+R R Yes
Tag Information Ctrl+Alt+T g Yes
Select All l
Color Tags Now Ctrl+4 o
Refresh Document s
Absolute to Relative b
Relative to Absolute v
Translate Extended Chars Ctrl+E n
Select This Tag h

Window List





Undo

DESCRIPTION:
This function allows you to reverse the last action you have taken.    For instance if you have 
deleted/changed a block of text it can be recvovered.

LOCATION: Edit Undo

FEATURE:
1    Reverses the last action. For example, if you accidentally deleted some text, you could use Edit 

Undo to get it back.

USAGE TIPS:
1    If you make a mistake typing or editing you can undo that mistake,

· Move your mouse cursor to the Edit Undo option.
· It's found on the top line of HotDog’s main window. 
· Click once. You should see the options appear.
· Move down the options and select Undo last Typing.

2    You can do this quickly by using CTRL+z for each undo level.

3 Remember, if you make a number of changes to some text only the last change you have made 
is restored.    The only way to recover a mistake if you have made more than one change is to 
load the last saved file.      Save early, save often!



Cut

DESCRIPTION:
This removes highlighted text from your document and puts it in the Clipboard.

LOCATION: Edit Cut

USAGE TIPS:
1  The cut tool allows chop out a chunk of text you have highlighted with your mouse.

2    The text is now stored in the clipboard.    You can cut & paste slabs of text.    If you want to 
position the cut text, 

· Move your mouse to the desired position.
· Then either use the key combination of CTRL-V 
· Or move your mouse to the Paste option in the Edit menu.
· The cut text is now positioned on your page.



Copy

DESCRIPTION:
This takes a copy of highlighted text in your document and puts it in the Clipboard . Text can be pasted 
from the Clipboard into a document.

LOCATION: Edit Copy

USAGE TIPS:
If you want to copy something from the clipboard then, 

· Move your mouse to the desired position.
· Then either use the key combination of CTRL-V 
· Or move your mouse to the Paste option in the Edit menu.
· The cut text is now positioned on your page.



Paste

DESCRIPTION:
This inserts the contents of the Clipboard in your document. The information remains in the clipboard.    
You can use Paste to insert the same information repeatedly.

LOCATION: Edit Paste

USAGE TIPS:
If you want to paste something from the clipboard then, 

· Move your mouse to the desired position.
· Then either use the key combination of CTRL-V 
· Or move your mouse to the Paste option in the Edit menu.
· The cut text is now positioned on your page.



Append

DESCRIPTION:
This takes a copy of highlighted text in your document and adds it on the end of any text already in the 
Clipboard . Text may then be pasted from the Clipboard.

LOCATION: Edit Append

USAGE TIPS:
Append is different from Copy because Copy will replace whatever is in the Clipboard already.



Find

DESCRIPTION:
This command lets you search for text in your documents.      When you choose this option you will be 
presented with a dialog box. 

LOCATION: Edit Find

USAGE TIPS:
Say you are searching for some text in your Web document.    A typical search involves the 
following,

· Enter the text you are searching for into the Find Text box.
You can use one of 2 methods.

· Method 1:
You can either highlight the text using the mouse.
Or you can go to the Edit menu.

· Method 2:
Select the Find option.
Then enter the search string.
The former is faster!

· Select one, some or all of the search options listed above.
· Press OK

FEATURE:
There are a several options.    Options can be used together or used in combination with each other. 
For example you can have Find & Case Sensitive together to do an exact search.    The search 
options include, 

· Find:
The text you want to search for.

· Case Sensitive:
If this option is enabled then a search for the will find “the” but not “The”.

· Match Whole World Only:
If this option is enabled then a search for the will find “the” but not “then”

· Search All Documents:
This will search all open documents, instead of just the current one.

· Find Next:
This will find the next match for the specified text, starting from the current cursor position.



Replace

DESCRIPTION:
This command lets you search for text in your documents and replace it with something else.

LOCATION: Edit Replace

USAGE TIPS:
Say you want to replace a piece of text.    You would typically do the following,

· Enter the text you are searching for into the Find Text box.
· Enter the text you wish to replace it with into the Replace With box.
· You can use one of 2 methods.
· Method 1:
· You can either highlight the text using the mouse.
· Or you can go to the Edit menu.
· Method 2:
· Select the Find option.
· Then enter the search string.
· The former is faster!

· Select one, some or all of the search options listed above.
· Press OK

FEATURE:
1 There are a several options on the dialog box as well as search options.    They include the,

· Ability to highlight text, select the Replace option & the highlighted text appears in the Find text 
box. 

· You can highlight & enter long strings as long as you don’t enter a return! 
· You can select previously selected strings by using the small down arrow graphic to the right of 

the Find text & Replace with text boxes.

2 Search options can be used together or used in combination with each other.    For example you 
can have Find & Case Sensitive together to do an exact search.      The search options include, 

· Find:
The text you want to search for.

· Case Sensitive:
If this option is enabled then a search for the will find “the” but not “The” 

· Match Whole World Only:
If this option is enabled then a search for the will find “the” but not “then”

· Search All Documents:
This will search all open documents, instead of just the current one.

· Find Next:



This will find the next match for the specified text, starting from the current cursor position.



Tag Information

DESCRIPTION:
HotDog lets you customize tags inserted through the Tags Menu,    List option..    This option allows you 
to 

· move tags between menus,
· change descriptions, 
· create custom tags, 
· specify the HTML codes and text each tag inserts.

LOCATION: Edit TagInformation

FEATURE:
1 The Edit Tag Information dialog box allows three main operations, 

· Find a Tag,
· Edit a Tag,
· Delete a Tag

and some other things such as
· Move a tag from one tag grouping to another,    eg: Document to Heading.

2 Once you do one of the above you can do some or all of the following,
· Assign a Tag to group, ie:    Netscape, Microsoft, HTML 2.
· Describe a Tag.
· Mark-up a Tag.
· Assign a short-cut key to a tag.

3 There are several general options you can choose from
· Menu

This determines which section of the Tags menu the tag will belong to. To move a tag to a 
different menu, drag the tag description onto the new menu.

· Tag Description
The description of the tag appears as a menu item in the Tags menu, and a list item in the 
Tags list. To change the description, click on it and type a new one.

· Beginning Markup
This is the HTML text that will be inserted before the cursor and/or any selected text. This 
does not have to be HTML code - it can contain any text you like.

· Ending Markup
This is the HTML text that will be inserted after the cursor and/or any selected text. This 
does not have to be HTML code - it can contain any text you like.

· Add New Tag
Adds a new tag to whatever menu is selected in the Menu list.

· Delete Tag



Deletes the tag that is currently selected in the Tag Description list.
· Type

Lets you assign the tag to a particular group. HotDog ships with tags grouped into either 
standard tags, Netscape Extensions, or Microsoft Extensions. 



Select All

DESCRIPTION:
Select All will highlight all of the text in the current document. To remove the highlighting, just click on a 
blank area of the document.

LOCATION: Edit SelectAll

USAGE TIPS:
Use this option if you want to,

· copy all the contents of a file to the clipboard. Select all, then copy.
· cut a large section of text. Select all then cut.
· place a tag around a section of text.



Color Tags Now

DESCRIPTION:
The Color Tags now  option is used in-conjunction when you change the on-screen appearance.      
Customization of    Tags with color, allows for easy visualization of exactly what type of tags you’re    
currently using. 

LOCATION: Edit ColorTagsNow

FEATURE:
1  The real work is done in the Tools menu, Options selection.    If you go to the Dialog box    and 

select the color folder you can set the on-screen attributes of,
· Screen color,    Foreground & Background.
· Default HTML Tag color
· HTML Tag type
· HTML Tag color.

2    By using the Color Tags Now option along with the previously described you can visually identify 
different tags by color.    But let’s get one thing straight, Tag color customization will not produce 
colored text for Web pages! 

3  Double click on any colour code to highlight it, click the right mouse button and choose the "Edit 
Color" option and choose your new colour.    Simple !



Refresh Document

DESCRIPTION:
Asks the document to redraw itself in case the screen's display has some problems.

LOCATION: Edit RefreshDocument

USAGE TIPS:
Screen problems may occur from time to time.    If something odd is appearing on the screen,    try this 
option to refresh the screen you are currently working on.
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Absolute to Relative

DESCRIPTION:
This function converts a link to an absolute to a relative link.    It’s a good idea before you send you Web 
documents to your ISP convert all your files from relative links to absolute links.      If you want to do this 
to Highlight your selected link and use this option.

LOCATION: Edit Absolute to Relative

FEATURE:
If you want change your links,    highlight your selected link and use this option.

USAGE TIPS:
It’s a good idea before you send your Web documents to your ISP convert all your relative links to 
absolute links.    The reason is simple,    your ISP most likely will not store your files in a directory 
structure as you have specified using absolute links.



Peter, please check carefully exactly what part of the relative URL
needs to be highlighted for this command to work - I think it has to include
the quotes around the reference....experiment and see what happens.    If its
too weird then I'll fix it.



Relative to Absolute

DESCRIPTION:
This function converts a relative link to an absolute link.    It’s a good idea before you send you Web 
documents to your ISP convert all your files from relative links to absolute links.      If you want to do this 
to Highlight your selected link and use this option.

LOCATION: Edit    Relative to Absolute

FEATURE:
If you want change your links,    highlight your selected link and use this option.

USAGE TIPS:
It’s a good idea before you send you Web documents to your ISP convert all your relative links to 
absolute links.    The reason is simple,    your ISP most likely will not store your files in a directory 
structure as you have specified using absolute links.



Translate Extended Chars

DESCRIPTION:
Translate extended characters changes foreign characters into their respective HTML codes.

LOCATION: Edit TranslateExtendedChars

USAGE TIPS:
You will find that it’s pretty hard to type some of these characters in.    Don’t try, use this option.



Select This Tag

DESCRIPTION:
Selects the current tag you're pointing at.

LOCATION: Edit SelectThisTag

FEATURE:
By placing your cursor inside either tilde, “< >”  that surrounds a tag and selecting this option the entire 
tag is highlighted.

USAGE TIPS:
You could use this feature if you want to accurately select a tag to,

· Delete it, 
· Cut or 
· Place into the clipboard
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View

The View menu option gives you access to the Toolbone option (on/off), quick Tags insertion menu 
and the insert special characters menu and the File - manager menu.      Take note of the following,

· That the default shortcut key for locating the View menu is ALT+V
· That the default shortcut letter for locating a particular option in the View menu are to the 

right of the shortcut
· That any View menu option marked “Yes” in the dialog box column indicates an associated 

dialog box.

Name Letter Dialog Box
Toolbone b
Tags T Yes
Special Characters C Yes
HotDog File Manager F Yes

Window List



Toolbone

DESCRIPTION:
The Toolbone (Bonebar) is found below the menubar in the shape of a bone.    It contains eight well used 
features on the bone.    To the left and right of the Toolbone notice the HotDog32 logo (left side) and the 
Sausage Logo (right side).

LOCATION: View Toolbone

FEATURE:
1 The Toolbone contains, Preview, New, Open, Save, Upload, Rover, Toolbar & Help.

2 The HotDog32 Logo & Sausage logo are not just pretty pictures.    If you click on the HotDog32 
logo a piece of HTML is inserted into your page to show you have used HotDog to make your 
page.    If you click on the Sausage logo,    Rover will start up.

3 If you want to turn the Toolbone back on/off, 
· Go to the Toolbone option, 
· Click on it.
· You should notice the small tick on the left hand of the text.
· If the tick is there, the Toolbone is on.

USAGE TIPS:
1 If you find the Toolbone is taking up too much space you can select this option to turn it off.      

When you    turn the Toolbone off it stays off.    If you re-start HotDog the Toolbone will not be turned 
on until you select to do so.

2 If you want to tell the world you have used HotDog32 to create you Web page then, click on the 
HotDog32 logo and the following HTML is inserted into your page,

· <IMG SRC=http://www.sausage.com/dogicon.gif height=45 width=50> 

· This page was created with the <a href="http://www.sausage.com">

· <strong>HotDog 32</strong></a> Web Page Editor



Tags...ALL

DESCRIPTION:
The Tags List provides an easy way to insert any tag or attribute into your document.    Note that the 
contents of the Tags List and the Tags Menu are almost identical.    The difference is, this tags list has all 
the tags alphabetical but not grouped into their respective tag types.

Eg: The <BR> or “break” tag in this option can be found alphabetically.    In the Tags menu the same    tag will be 
found under the document tag type option.

LOCATION: View Tags…[ALL]

FEATURE:
Selecting the “Tags all” option will present you with a window which contains an alphabetical list of all 
currently supplied tags. 

USAGE TIPS:
1    If you want to find a tag quickly then use this option rather than the Tag menu, where you have to 

remember what tag and what tag type it can be found under.

2    Just select the tag from the list, and double-click on it with the left mouse button, or drag it into 
your document.

3    If you don’t remember the precise syntax of the tag you want to insert, enter what you know into 
the bottom left text box and press the “Find again”    button.

4    If you have selected some text in your document, the tag will be applied to this text. For example, 
· If you have selected the word “HotDog”, 
· double-click the Blinking tag. 
· The selection will be replaced with <BLINK>HotDog</BLINK>



Special Characters

DESCRIPTION:
Provides easy access to non-English (non-keyboard) characters, like accents and symbols.    You would 
typically use this option to insert a character code.

LOCATION: View SpecialCharacters

FEATURE:
The character codes list can be seen by choosing Special Characters from the Insert menu. 

USAGE TIPS:
To insert a character code in your document,      choose the character you want to insert from the list by 

· Clicking on it in the list or
· Double-click on it with the left mouse button, 
· Or drag it onto your text.



HotDog File Manager

DESCRIPTION:
The HotDog File Manager provides an easy way to insert local hypertext links, images, and pre-
formatted text into your document. Choose the file you want to insert from the File Manager, then drag it 
into your document. If HotDog cannot determine whether the file is a hypertext link, image, or text file,    
you will be asked to choose the type from a list.

LOCATION: View HotDogFileManager

FEATURE:
The HotDog File Manager will stay on screen until you click OK or Cancel.      You can create a local 
hypertext link by 

· dragging files from the HotDog or Windows File Manager. 
Or 
· Go to the Insert menu
· Select the “Jump To A Document On This System” option.

USAGE TIPS:
1 To delete a file in the HotDog File Manager, 

· Click on it 
· Press the Delete key on your keyboard. 
· You will be asked to confirm that you want to delete this file.

2 HotDog can also accept files dragged from the Windows File Manager.    If you drag multiple files 
from the Windows File Manager, they will all be inserted.

3 Notice the file formats are in the UNIX file format not DOS.
<A HREF="file:///C|/APP/HOTDOG_PROGRAMS/HD32/test.htm"></A></BODY>
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Insert

The Insert menu option contains operations related the insertion of “images, text, tables, lines, 
URL’s etc.” into a Web document.
Take note of the following,

· That the default shortcut key for locating the Insert menu is ALT+I
· That the default shortcut letter for locating a particular option in the Insert menu are to the 

right of the option name.
· That any file menu option marked “Yes” in the dialog box column indicates an associated 

dialog box.

Name Ctrl Letter Dialog Box
Image I Yes
Image (Advanced) v Yes
Embedded Item E Yes
Marquee M
Form Element F Yes
Hypertext Targets H Yes
Table Ctrl+T T Yes
List Ctrl+L L Yes
Horizontal Line z Yes

Text File T Yes
Special S

Simple URL F4 m Yes
Jump to a Document in This System J Yes
Jump to a Document on Another System A Yes
Jump Within This Document W Yes
Launch an Internet Service u Yes
ActiveX X Yes



Image

DESCRIPTION:
The Image menu provides for a simple and convenient way to insert images into your Web document.    
Images can be used to take the user to another document when they are clicked.

LOCATION: Insert Image

FEATURE:
1    The menu presents you with three options,

· Image File, Let’s you load an image.
· Document to Launch What document is loaded when clicked.
· Alternative Text Description Web browsers such as LYNX.

2    Images can be used to take the user to another document when they are clicked.    If you want 
the image to work this way, 

· Choose an image to be inserted in the Image file option.
· Insert a Web document in the Document To Launch field.
· Type in a description of the image in the Alternative Text Description field.

3    If you want to create an image that does nothing when clicked, all you need to do is,
· Choose the image file 
· Type in a description of the image in the Alternative Text Description field.

USAGE TIPS:
1    For more control over an images appearance then try Insert AdvancedImage. 

2    Make it a habit to fill in the “Alternative text description”.    If you consider the eighty/twenty rule, 
eighty percent of the viewers may be able to see your image, but the remaining twenty percent 
using Browsers with limited capabilities such as LYNX will only see [IMAGE]!

3  Be very careful with absolute and relative  file references when inserting images and launching 
documents.    You can get into a lot of trouble when you hand over your Web document    to your 
ISP if you don’t understand absolute and relative file references.



Image (Advanced)

DESCRIPTION:
The Image (Advanced) screen lets you specify all properties for an image <IMG>,    figure <FIG> or 
Image Map (ISMAP).    The information here applies to images,    figures and Image Maps alike.

LOCATION: Insert Image(Advanced)

FEATURE:
1    The menu presents you with the following options,

· Insert Image,    Figure,      Image Map (ISMAP)
· Image File
· Low Resolution Image File (LOW SRC)
· Alternative Text Description
· Width ,    Height      &      Border Width
· Horizontal Distance from Text
· Vertical Distance
· Alignment

2    You can build an external Hypertext link to an external file or URL using the small hand icon 
found to the right of Insert Image,    Low Resolution Image File

USAGE TIPS:
1    If you want an image file specified in lower case, click the “Insert as Lowercase” option from the 

top right hand position of the properties box.

2    If you want make your Web page load faster, you can do this through loading text and then 
graphics. You have to specify,

· The image file name in the Image File item
· The Width of the image in Pixels.
· The Height of the image in Pixels.
· You will notice when you choose an image,    both width & height in pixels will appear

3    For simple images, you might want to use the standard Image screen instead,    found at Insert 
Image.



Embedded Item

DESCRIPTION:
Embedded items can be viewed by users who have a suitable application set up on their computer.      
For example, you could embed an Excel spreadsheet, and any user with Excel would be able to view it 
(of course, it's probably meaningless to any user that doesn't have Excel).    The user views the 
spreadsheet by double-clicking it.

LOCATION: Insert EmbeddedItem
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Marquee

DESCRIPTION:
The MARQUEE tag allows the creation of a scrolling text area on your Web page.    The HotDog Marquee 
dialog window relates directly to the Marquee tag which is a Microsoft Addition to HTML.

LOCATION: Insert Marquee

FEATURE:
A MARQUEE lets you create a scrolling text area. This is a useful space for advertising or other 
information. There are a number of attributes that let you control the use of Marquee dialog:    They are,

· Marquee Message
· Behavior
· Scroll Direction
· Time between Messages (Milliseconds)
· Space between Messages (Pixels)
· Number of Times To Repeat Loop
· Background color
· Text Alignment
· Marquee Height & Marquee Width
· Horiz. Space & Vert. Space

USAGE TIPS:
1    To make a loop repeat continuously,

· Enter -1 or INFINITE 
· Into the “Number of times to repeat Loop” option

2    The MARQUEE tag is only visible through a Microsoft Explorer browser or Microsoft Explorer 
compatible browser.



Form Element

DESCRIPTION:
Forms let users send information to you or your server.      Forms run programs, or scripts, through the 
Common Gateway Interface (CGI). 

Forms can also be used to send mail to someone.      This can be useful if you don't know anything 
about CGI programming: the form can mail the information directly to your account. Information sent this 
way is not formatted, but can still be understood.

LOCATION: Insert FormElement

FEATURE:
1    HotDog supports the following HTML 3 specification form elements.

· Text Box 
· Text Area 
· Submit Button 
· Reset Button 
· Check Box 
· Radio Button 
· Password Box 
· Hidden Box 
· Image
· List Box

2    You can create multiple form elements in one session.    You can also mix and match form 
elements to create complex forms using the above form elements.

USAGE TIPS:
1    To create a form in HotDog, choose    Insert FormElement.

2    You will be asked to choose what sort of form element you want to create. If this is the first form 
element in your document, when you choose OK you will be taken to the Form Details screen.

3    The Form details screen will remain visible when you press OK. This is so that you can create a 
form with multiple elements without having to reload the screen each time.



Form Details 

DESCRIPTION:
This specifies attributes for the entire form.    This screen only appears    when you use the Form Element 
screen to create the first form element in your document.

LOCATION: Insert FormElement

FEATURE:
The information here tells the browser what to do with the form, used to define the <FORM> element.    
Only the METHOD and ACTION (URL to send data to).
1    Method

This may be either GET or POST. This depends on what you want to do with the form, and the 
setup of your server.

2    URL to Send Data to (Action)
The ACTION attribute is the URL that will process the form data. Generally, this will be a CGI 
program, but can be any valid Internet resource. For example, you could use 
mailto:sales@sausage.com as your Action URL.

3    MIME Content Type
Specifies the MIME encoding for the form. This will vary depending on what the form does and 
how it works. The MIME Content Type is not required.

4    URL for Script (HTML 3)
This lets you specify the URI for scripts that will be downloaded to the user's machine and 
processed locally.

USAGE TIPS:
1  The Form details screen will remain visible when you press OK. This is so that you can create a 
form with multiple elements without having to reload the screen each time.

2    For    “URL for Script (HTML 3)” & “URL to Send Data to (Action)” you can build an external 
Hypertext Link.



Hypertext Targets

DESCRIPTION:
Hypertext Targets let you jump to specific locations within documents.    You can   jump   to a target in the 
same document, or another document.    Targets are most often used in long documents which are 
divided into several sections.

LOCATION: Insert HypertextTargets

FEATURE:
When you choose this option a small dialog box will pop up.    Enter an ID name for the target.    Press 
OK.

USAGE TIPS:
1    To create a link to a target in the current document, choose,

· Insert    JumpWithinThisDocument. You can then choose the desired target from a list of 
all targets in the current document.

2    To link to a target in a different document, choose
· Jump to a Document in This System or
· Jump to a Document on Another System from the Insert menu to create the initial link. 

3    Specify the target name after the file name, with a #. For example, 
<A HREF="document.htm"> 

links to a document on the same system. 

4    If this document contained a target called "contents", you would use:
<A HREF="document.htm#contents">



Table

DESCRIPTION:
HotDog gives you a graphical way to create tables and fill them with information.    HotDogs table maker 
used in conjunction with ROVER (via Preview button) allow you to build forms with one eye on the form, 
the other on the contents you are inserting.

LOCATION: Insert Table

FEATURE:
1    The following options are available including,

· Caption
Specifies a caption for your Table.

· Border
If you want a border around the edge of your table, specify the width here. If you enter 0, 
your table will not have a border.

· Rows
Sets the number of rows in the table.

· Columns
Sets the number of columns in the table.

· Heading Rows
Sets the number of Heading Rows in the table. These will be shown in the Sample Table 
with a gray background.

· Heading Columns
Sets the number of Heading Columns in the table. These will be shown in the Sample Table 
with a gray background.

· Width
Sets the Width of the entire table. This can be an absolute value in pixels, or a relative 
value. HotDog treats Widths with a % symbol at the end as relative, and anything else as 
absolute. This attribute will not be displayed in the Sample Table.

· Height
Sets the Height of the entire table. This can be an absolute value in pixels, or a relative 
value. HotDog treats Heights with a % symbol at the end as relative, and anything else as 
absolute. This attribute will not be displayed in the Sample Table.

· Cell Spacing
Cell Spacing is the amount of space between each cell. This attribute will not be displayed 
in the Sample Table.

· Cell Padding
Cell Padding is the amount of space between the border of the cell and the contents. This 
attribute will not be displayed in the Sample Table.

2    Once you've created a table with HotDog, you can use the Table editor to make changes to it. 
Just highlight everything from (and including) the <TABLE> to the </TABLE>, then click the Table



3    View the table you have created, by selecting  Preview button.

4    Highlight multiple lines of text and bring up the table editor,    Insert Table.    Each line will be put 
into a different row of the table - a good way to get the grunt work done.    You can also paste into the 
grid on the table editor.

USAGE TIPS:
1    To create a form do the following, 

· Fill out the table parameters described above.
· Type directly into the fields (Rows & Columns) the information you want to insert.
· Check how you are using the Preview button.

2    Tables are new to the HTML specification. They are supported in Netscape 's Extensions to HTML 
as well as HTML 3.

3    You can view the table your creating by pressing the preview button.



List

DESCRIPTION:
The List dialog allows you to create list’s. With this option you can quickly create list’s using the List 
Dialog yet maintain control over the list's attributes.

LOCATION: Insert List

FEATURE:
1    Add new items to a list by Clicking the Add button.
2    Modify/Delete text.    Select the text with a mouse to allow editing of each line.
3    Assign a List heading to a List.
4    Create a list that can be,

· Bulleted
· Numbered
· Definition
· Plain

5    Ability to change the appearance of the bullet ( round, square & circle).    Applying to bullets only 
this effect will appear on Netscape compatible browsers only.

USAGE TIPS:
1  You can create a list by doing the following,

· Go to the option    Insert List
· Add /Modify or Delete text in the dialog box.
· Give the list a heading.
· Select the bullet type,    Circle, Disc, Square.
· Create the list:      Bulleted,    Numbered,    Definition or Plain.

2    You can also enter the list text manually, select the text then,
Go to the option    Insert List highlight the text continue from step 3 above.

3    HotDog gives you two ways to create lists (apart from typing the HTML yourself or inserting it from 
the Tags List  or Tags Menu).



Horizontal Line

DESCRIPTION:
This will create a Horizontal Line using the <HR> tag. 

LOCATION: Insert HorizontalLine

FEATURE:
There are several options which you can set either on the dialog and/or edit in HotDog.    They are,

· Width
· Alignment
· Thickness
· No Shading

USAGE TIPS:
1    This dialog offers options only available under the Netscape Extensions to HTML or HTML 3. If 

you want to maintain compatibility with most current browsers you should leave these fields blank.

2    You can manually edit the bolded variables in the tag. 
<HR WIDTH=120<HR SIZE=100>% ALIGN=left SHADE>



Text File

DESCRIPTION:
The Text File option lets you insert the contents of a plain text file into your document at the cursor 
position. You can also do this by dragging the text file into your document from File Manager or the 
HotDog File Manager. 

LOCATION: Insert    TextFile

USAGE TIPS:
1    By default, HotDog will insert the text as Pre-formatted, using the <PRE> tag. This means that 

most browser will render it in a monospaced font like Courier. 

2    If you do not want HotDog to do this, you can disable it from the Option General screen.      You 
can do this by,

· Going to Option General
· Move your mouse cursor to ,” Insert Text as Pre-formatted <PRE>”
· Click your mouse on the tick.
· When the tick is not present, the option is off.



Special

DESCRIPTION:
HotDog lets you insert a number of special codes into your documents.    These codes are listed below. 
You have the ability to customize the Date and Time formats.

LOCATION: Insert Special

FEATURE:
1    This feature allows you to insert the following into your Web page.

· Date & Time,
· File Name
· HotDog Version
· Windows Version
· Registered User name
· Registered Company name

2    For the Date & Time option you can choose a list of predefined date/time formats or customize 
the date/time format to suit your own needs.

3    You can choose to update all date/time formats when you publish your web document by 
selecting the tick option.

USAGE TIPS:
1    Date and Time:    You can either insert the current date and time, or the publishing date and time. 

The latter will be updated whenever you   Publish   the document.      Choose the format you want to 
display the date and/or time in from the list provided.

2    File Name:    The name of the current file.

3    HotDog Version:    The version of HotDog used to create the file. This number is displayed in the 
About box.

4    Windows Version:    The version of Windows used. This is returned by the operating system.

5    User:    The person this version of HotDog is registered to. This is set when you register HotDog, 
and cannot be changed.

6    Company:    The company this version of HotDog is registered to. This can be changed from the 
HOTDOG.INI file if you're a registered user.



Simple URL

DESCRIPTION:
The Simple URL menu is the fastest way to create hypertext links.

LOCATION: Insert SimpleURL

FEATURE:
From the Simple URL option you can,

· Type or load a URL
· Hopefully give the URL a meaningful name
· Build an External Hypertext Link.

USAGE TIPS:
1    For URL’s:     The text that the user will click on to follow the link. This defaults to the URL, but you 

can change it to anything you like.

2    For Descriptions:    The URL (Universal Resource Location).
· Click the drop-down arrow at the right of this box
· You can see    a list of all the URLs you've used before.
· They are in alphabetical order.



Jump to a Document in This System

DESCRIPTION:
Creates a Hypertext Link between the current document and another document on your computer. You 
can test the link between these "local" documents without being connected to the Internet.

LOCATION: Insert      Jump to a Document in This System

FEATURE:
1  You can create a local hypertext link by choosing    Jump To A Document On This System from 

the Insert menu.

2  You can also create the links by dragging files from the View    HotDog File Manager or the    
Windows File Manager.

USAGE TIPS:
To create a hypertext link from the HotDog file manager, 

· Go to the HotDog File Manager,      View    HotDog File Manager
· Select the file you wish to link from the right hand text box labeled, Files.
· Go to the bottom left hand side of the dialog box.
· Press the Make Link button.



Jump to a Document on Another System

DESCRIPTION:
This creates a Hypertext Link between the current document and (usually) a document on another 
computer.    In doing so you build a URL for the external document. You can only test these "external" 
links when you are connected to the Internet. 

LOCATION: Insert    Jump to a Document on Another System

FEATURE:
1  Fill in all the required details to create the URL for the external document.    The details include,

· Resource type
The resource type describes the protocol used.    A protocol is a method that allows the 
access and transfer of information between server and person requesting the.      There are 
many of them, each with their own particular protocol.

· Host
The host name is the name of the host system, the system a file is located.

· Port number
The port number is given to connect to a specific port on the host machine.

· Path
The pathname is the physical path a file is located on the host.

· Filename
The name of the file.

· Target
Specifying a target allows a document to be loaded at a specific point.

USAGE TIPS:
External hypertext links can also be made to other Internet elements, such as

· gophers,
· FTP servers, and news groups.
· USENET Newsgroup
· WAIS database
· User send Mail to Someone
· Telnet session



170696
work
dropped from here was not relevant.

2    HotDog provides separate dialogs for news and mail links.    This makes it easier for you to keep 
track of all the different types of URL, by giving news and mail addresses their own drop-down 
lists.



Jump Within This Document

DESCRIPTION:
This option lets you create a Hypertext Link to a target in the current document.. 

LOCATION: Insert    Jump Within This Document

FEATURE:
1    You can choose a destination to jump to from the list box.

2    More destinations can be added to the list by choosing Insert   Hypertext target    or using the ID 
attribute in a HTML element.

USAGE TIPS:
1    Targets are most often used in long documents which are divided into several sections.    In large 

documents.

2  To create a link to a target in the current document, choose Jump Within This Document from 
the Insert menu.      You can then choose the desired target from a list of all targets in the active 
document.



Launch an Internet Service

DESCRIPTION:
This lets you create a Hypertext Link to an Internet service. You might want to take the user to your 
favorite newsgroup, or let them send mail to you.

LOCATION: Insert    Launch an Internet Service

FEATURE:
The dialog for this option shows a list of common Internet services.    For some, like news and mail, you 
need to enter a specific newsgroup or mail address; for others, you will need to build the URL.      The 
common Internet services include,

· An HTML file on Another System
· Go to an FTP Server
· Go to a USENET Newsgroup
· Go to a WAIS database
· Let the User send Mail to Someone
· Go to a Gopher
· Start a Telnet session

USAGE TIPS:
You will have to build a URL using the build external Hypertext link window which can be located 
Insert      Jump to a Document in Another System.



ActiveX

DESCRIPTION:
The ActiveX command presents you with a list of all OCX components on your system, some of which 
are ActiveX. 

LOCATION: Insert    ActiveX

FEATURE:
We've built this simple filter into the "Only Show ActiveX Controls" option on that screen, but it is not 
guaranteed to be correct.    You should also consider that,

· Which ActiveX files you have available to you. 
· This form is based on code written by Joe Robinson and    was available for public use.
· More information on ActiveX is available from http://www.microsoft.com

USAGE TIPS:
How do you know what an ActiveX is? - there's no simple way to tell unless you put them there !    A 
good rule of thumb, so far, is that the name of standard OCX controls ends in "Control" while ActiveX 
controls are called "Objects".



310596
Work:

Started Tags,    Check if the rest of the menu titles are correct!
I need the Lemay book so I can explain clearly what each tag grouping is
Do not proceed until I can explain clearly

030696
Work:    Tags Menu

Difficult to define what headings are for. 
Eventually found a couple of good sources to sort it out.
http://www.thecoo.edu/~menon/html.html#grafix
Also noticed that heading differences b/w base menu to top.    CORRECT!
Have to include the following

Descriptions for each of the tags
Explanation of what each tag menu has to offer!
Location should have description of what it means!!

040696
Work:

EM Mark for TABLES
Ripped out the stuff relating to menus it’s there for no reason.
Included where, What’s in there.
Have to do, What’s a Custom Tag?

How do I create a Custom Tag?
How do I search for a tag in Tag Menu?

Included How do I decipher this location?
What do these descriptions mean?

NEED TO INCLUDE LOCATION FOR ALL HEADINGS PAGES!!!

120696
Work

Test
What’s an Attribute??



Tags

The Tags menu allows you to insert tags or tag elements into your web document.      You do this by 
choosing tags from their groupings listed below.    If you can’t remember exactly which grouping a tag 
is located you can also search for a tag.

· That the default shortcut key for locating the Tags menu is ALT+T
· That the default shortcut letter for locating a particular option in the Tags menu are shown in 

the Letter column.

Name Letter
Document D
Body B
Content C
Headings H
Attributes A
Graphics G
Font F
Lists L
Forms r
Tables T
Miscellaneous M
Custom u



Document

LOCATION: Tags Document

FEATURE:
You can search for a tag in this dialog box.



Body

LOCATION: Tags Body

FEATURE:
You can search for a tag in this dialog box.



Content

LOCATION: Tags Content

FEATURE:
You can search for a tag in this dialog box.



Headings

LOCATION: Tags Headings

FEATURE:
You can search for a tag in this dialog box.



Attributes

LOCATION: Tags Attributes

FEATURE:
You can search for a tag in this dialog box.



Graphics

LOCATION: Tags Graphics

FEATURE:
You can search for a tag in this dialog box.



Font

LOCATION: Tags Font

FEATURE:
You can search for a tag in this dialog box.



Lists

LOCATION: Tags Lists

FEATURE:
You can search for a tag in this dialog box.



Forms

LOCATION: Tags Forms

FEATURE:
You can search for a tag in this dialog box.



Tables

LOCATION: Tags Tables

FEATURE:
You can search for a tag in this dialog box.



Miscellaneous

LOCATION: Tags Miscellaneous

FEATURE:
You can search for a tag in this dialog box.



Custom

LOCATION: Tags Custom

USAGE TIPS:
You will only find a custom Tag if you have created one.

FEATURE:
You can search for a tag in this dialog box.





290596
Work:

Had trouble working with “16 Bit…” context heading.    Solved by using name.
Links in tutorial, work this out!
Brian you changed the title from the last version!
Have trouble with the Menu title s & graphics. 
E-mail Brian about this.
E-mailed Brian, the button text is good.    Reason is that it describes the menu location

130696
Work:

tested
accuracy OK
spelling OK
inclusions

Q    should I link to customize toolbars?
A    Jump to customize toolbars.



Toolbars

The Toolbar menu option contains a list of all the floating toolbars currently in existence.    This 
option allows you to turn on/off any toolbars currently listed in the menu.

Take note of the following,
· That the default shortcut key for locating the Toolbar menu is ALT+o
· The toolbars currently listed are only default toolbars.    You can create your own, delete 

the default toolbars or not have any at all if you wish.
· The tick to the left of the Toolbar name means the toolbar is active on screen.    If you want 

to turn a toolbar off, 
· Simply click the name of the toolbar until the small tick disappears. 
· As the tick disappears the toolbar will be removed from the work area.

Name
Common Commands 
Tags
Your Text



Common Commands

DESCRIPTION:
The Common Commands Toolbar toggles off    and on, the default Toolbar of the same name. 

LOCATION: Toolbar

FEATURE:
1  The tick that appears to the left of the toolbar name indicates if the Toolbar is visible.    If the 

Toolbar name is ticked, it is visible on the screen.    If the Toolbar has no tick, it will not be present 
on the page

2    The names in the Toolbar list represent the given name of a Toolbar.

3    When you load the program for the first time, only the default Toolbars, “Common commands”, 
“Tags” and the “Your Text” Toolbar will appear. 



Tags Toolbar

DESCRIPTION:
The Tags Toolbar toggles off/on the default toolbar of the same name.

LOCATION: Toolbar

FEATURE:
1  The tick that appears to the left of the toolbar name indicates if the Toolbar is visible.

2    The names in the Toolbar list represent the given name of a Toolbar.

3    When you load the program for the first time, only the default Toolbars, “Common commands”, 
“Tags” and the “Your Text” Toolbar will appear. 

4    You can customize any toolbar to your own requirements!    As you create your own floating 
toolbars their names will appear in the Tags menu as well.

USAGE TIPS:
1  If the Toolbar is ticked, the Toolbar will be visible on the screen.

2    If the Toolbar has no tick, the Toolbar will not be visible on the page



Your Text

DESCRIPTION:
The Text ‘n’ Stuff Toolbar toggles off    and on, the default Toolbar of the same name.    Notice the tick that 
appears to the left of the Toolbar name.    If the Toolbar name is ticked, it is visible on the screen.    If the 
Toolbar has no tick, it will not be present on the page

LOCATION: Toolbar

FEATURE:
1  The tick that appears to the left of the toolbar name indicates if the Toolbar is visible.

2    The names in the Toolbar list represent the given name of a Toolbar.

3    When you load the program for the first time, only the default Toolbars, “Common commands”, 
“Tags” and the “Your Text” Toolbar will appear. 

4    You can customize any toolbar to your own requirements!    As you create your own floating 
toolbars their names will appear in the Tags menu as well.

USAGE TIPS:
1  If the Toolbar is ticked, the Toolbar will be visible on the screen.

2    If the Toolbar has no tick, the Toolbar will not be visible on the page



060696
Work

Started format
Have to check HTML 3.0 & <CENTER> tag
Have to do the Document Dialog



Format

The Format menu option gives you 

Take note of the following,
· That the default shortcut key for locating the Format menu is ALT+r
· That the default shortcut letter for locating an option in the Format menu are to the right of 

the option name.
· That any Format menu option marked “Yes” in the dialog box column indicates an 

associated dialog box.

Name Ctrl Letter Dialog Box
Font F Yes
Document Ctrl+D D Yes
Bold Ctrl+B B
Italics Ctrl+E I
Underline U
Blinking l
Big First Letter g
Center C



Format Font

DESCRIPTION:
There are a number of ways to Format font and other character attributes in HotDog.    This option allows 
you to 

· change a font’s relative size.
· change a font’s color.
· change eleven other visual attributes of a font.

LOCATION: Format FormatFont

FEATURE:
1    Change a fonts relative size

Font sizes can be expressed either as a size relative to the base font size, or as an absolute size, 
relative font size.      Sizes range from 1 to 7; the default size is 3. 

2    Change a font’s color
You can change the color of some text by clicking the small “text color option” found to the right 
of the    Base Font selection option.

3    Change other visual attributes of a font
You can alter eleven other visual attributes.    You can mix and match these font attribute 
combinations.    They include,

Bold, Emphasized, Strong, Underline, Italics,
Small caps, Blinking, Superscript, Subscript, Big, Small

USAGE TIPS:
1    You can choose only one option for font size and color,    but you can mix and match the other 

eleven visual attributes of a font. 

2  If you highlight text in your document before using one of the above options, the appropriate tags 
will be inserted at the start and end of the text, so that only the selected text is formatted.

3    If no text is highlighted, the start and end tags for the attributes will be inserted together.



Format Document

DESCRIPTION:
The Document dialog gives you an easy way to set document-wide attributes, like colors and 
background graphics.      The Document dialog is divided into three sections, 

· Document Information
· Graphics & color
· Links and Meta information

LOCATION: Format FormatDocument

FEATURE:
1    Modify Document Information

2    Modify Graphics & color
Change the colors of the background the foreground and links
Check text color against background color with the Background Reality Checker

3    Change Links and Meta information

USAGE TIPS:
1  Change the colors of the background,    foreground and links

2  Check text color against background color with the Background Reality Checker



Document Information alterable in Format Document

FEATURE:
You can specify information for the <HEAD> and <BODY> elements in your document.    All files except, 
“Document Title” are optional.    The following information can be changed,

Document Title
The name of the document. This will not be displayed in the document, but most browsers will display it 
on their caption bar. The document title is required.

Base URL Address
This provides a convenient way to record the URL of a document, in case it is read out of context (for 
example, if some downloads the document and reads it off-line). Relative Hypertext Links within the 
document will be based on this address. For example, if you use the base address of

<BASE HREF="http://www.sausage.com/index.html"> then a link like
<IMG SRC="gifs/sausage.gif> would be translated as 
<IMG SRC="http://www.sausage.com/index.html/gifs/sausage.gif>

Banner (HTML 3)
The banner stays at the top of the page at all times - it does not scroll with the document. This is 
useful for logos, tool bars, and so on.

Base Font Size
The size to base all relative Font Size changes on. The default is 3. Base Font Size can range from 
1 (the smallest) to 7 (the largest).

This document is a searchable index
This generates the ISINDEX tag, indicating that this document is an index document. As well as 
reading it, the reader may search for keywords in it. The document can be queried with a keyword 
search by adding a question mark to the end of the document address, followed by a list of keywords 
separated by plus signs. 

The ISINDEX tag would normally be generated automatically by the Web Server. If the server does 
not have a search engine, then this option will do nothing.

URL for Processing Queries
This provides the server with a URL to direct search queries to. This field is optional. 

Text to Ask User for Keywords
This provides the server with a URL to direct search queries to. This field is optional. 

Build External Hyper Text Link
Allows you to build a link to an external file or resource.



Graphics & color information alterable in Format Document

FEATURE:
1    Change the colors of the background the foreground and links

Document Text Foreground - the document text. 
Background - the document background.

Standard Link a hypertext link that the user has not yet followed.
Visited Link a hypertext link to a page the user has already been to.
Active Link a hypertext link    that is currently loading.

2    Check text color against background color with the Background Reality Checker
Our color sampler gives you an easy way to choose the colors for your document. Click on 
the item you want to change, then adjust its color with the RGB sliders, or click the RGB 
CODE button to choose the color graphically.    You can also change how the RGB code is 
displayed using the Decimal to Hex converter found just above the color sampler.

3    Specify a Background Graphic
Specifies an image to use as a background for the document. This image will be tiled across 
the page, and nothing else will be visible until the browser has rendered it. For this reason, 
these images should be very small files, and should not be interlaced.

4    Color Selection

5    Shades of Grey

6    Relative Lock



Bold

DESCRIPTION:
The Bold font option allows you to change a font’s bold attribute from normal to bold.    This option 
formats the text in ”Bold” type. 

LOCATION: Format Bold

FEATURE:
1    You can access this option through the

· Menubar As above
· Button on default Tags Toolbar Toolbars CommonCommands
· Default shortcut ALT +r, B    or CTRL+B
· Right mouse click
· Roll your own Toolbar.
· Roll your own    shortcut key.

2  You can also alter another eleven other visual attributes including the Bold option.

USAGE TIPS:
1    The use of Bold is not recommended; you should use Strong instead.

2    If you highlight text in your document before using one of the above options, the appropriate tags 
will be inserted at the start and end of the text, so that only the selected text is formatted.

3    If no text is highlighted, the start and end tags for the attributes will be inserted together.

4    You can apply combinations of the other eleven visual attributes of a font at the same time.



Italics

DESCRIPTION:
The Italics font option allows you to change a font’s attribute from normal to an “Italics”. 

LOCATION: Format Italics

FEATURE:
1    You can access this option through the

· Menubar As above
· Button on default Tags Toolbar Toolbars CommonCommands
· Default shortcut ALT+r or CTRL+E
· Right mouse click
· Roll your own Toolbar.
· Roll your own    shortcut key.

2  You can also alter another eleven other visual attributes including the Bold option.

USAGE TIPS:
1    The use of Italics is not recommended; you should use Emphasize instead.

2    If you highlight text in your document before using one of the above options, the appropriate tags 
will be inserted at the start and end of the text, so that only the selected text is formatted.

3    If no text is highlighted, the start and end tags for the attributes will be inserted together.

4    You can apply combinations of the other eleven visual attributes of a font at the same time.



Underline

DESCRIPTION:
The underline font option allows you to change a font’s attribute from normal to an “underlined”.

LOCATION: Format Underline

FEATURE:
1    You can access this option through the

· Menubar As above
· Button on default Tags Toolbar Toolbars CommonCommands
· Default shortcut ALT+r, U
· Right mouse click
· Roll your own Toolbar.
· Roll your own    shortcut key.

2    You can also alter another eleven other visual attributes including the Bold option.

USAGE TIPS:
1    Underline is a proposed HTML 3.0 Tag.

2    If you highlight text in your document before using one of the above options, the appropriate tags 
will be inserted at the start and end of the text, so that only the selected text is formatted.

3    If no text is highlighted, the start and end tags for the attributes will be inserted together.

4    You can apply combinations of the other eleven visual attributes of a font at the same time.



Blinking

DESCRIPTION:
Makes the text blink on and off when it is displayed. Some people object very strongly to blinking text on 
(mainly) aesthetic grounds, although it can provide useful emphasis. 

LOCATION: Format Blinking

FEATURE:
1    You can access this option through the

· Menubar As above
· Button on default Tags Toolbar Toolbars CommonCommands
· Default shortcut ALT+R, l
· Right mouse click
· Roll your own Toolbar.
· Roll your own    shortcut key.

2    You can also alter another eleven other visual attributes including the Bold option.

USAGE TIPS:
1    If you highlight text in your document before using one of the above options, the appropriate tags 

will be inserted at the start and end of the text, so that only the selected text is formatted.

2    If no text is highlighted, the start and end tags for the attributes will be inserted together.

3    You can apply combinations of the other eleven visual attributes of a font at the same time.



Big First Letter

DESCRIPTION:
This option provides a handy way to begin paragraphs with large letters (usually referred to as drop 
caps).

LOCATION: Format BigFirstLetter

FEATURE:
HotDog provides an option for setting the default size of the first letter.

USAGE TIPS:
1  This option provides a handy way to begin paragraphs with large letters (usually referred to as 

drop caps).

HotDog is a great program

2  To use it, select the text you want to begin with a large letter, then choose Big First Letter from 
the Format menu.

3  Note that this formatting will only be visible to browsers that can render the <FONT> tag.



Center

DESCRIPTION:
The <CENTER> tag lets you center text.    Currently it only works for Netscape browsers, and is not part 
of the HTML 3 specification. 

LOCATION: Format Center

FEATURE:
You can access this option through the

· Menubar As above
· Button on default Tags Toolbar Toolbars CommonCommands
· Default shortcut ALT+r, B
· Right mouse click
· Roll your own Toolbar.
· Roll your own    shortcut key.

USAGE TIPS:
1  It may be wiser to use the ALIGN token instead. 

Instead of     <CENTER>This is in the middle</CENTER>
use <P ALIGN="center">This is in the middle</P>

2    If you highlight text in your document before using one of the above options, the appropriate tags 
will be inserted at the start and end of the text, so that only the selected text is formatted.

3  If no text is highlighted, the start and end tags for the attributes will be inserted together.

4    You can apply combinations of the other eleven visual attributes of a font at the same time.



Snaglets

It had to happen. “The Snaglet’s have landed…”      HotDog now includes three of the most useful 
Snaglets for Web pages.    At the moment there are three Snaglet’s that have been imported.      There’s 
the Java animator, another for creating Frames & a Client Side Image Map tool.      Compared to the 
original programs, these tools are no thrown together hacks.    The functionality for each has been 
carefully refined.    The dialogs have been redesigned and any resultant HTML code and associated 
applets are seamlessly integrated.

Name Dialog Box
Java Animator Yes
Client Side Image Maps Yes
Frames Yes



Java Animator

DESCRIPTION:
The Java animator brings sound and movement to your Web page.    Just add some animation (.GIF 
or .JPG), some sound (.au) and you can create animation for your Web page.

LOCATION: Snaglets    JavaAnimator

FEATURE:

USAGE TIPS:

FEATURE:



Client Side Image Maps

DESCRIPTION:
The Client Side Image Map tool allows you to create Image maps.    Image maps let you use define an 
area on a graphic that can be treated as a hypertext jump.

LOCATION: Snaglets    ClientSideImageMaps

FEATURE:

USAGE TIPS:



Frames

DESCRIPTION:
Create frames visually using the Frame tool,    without having to have a great understanding of Frame 
HTML.    The Frame tool allows you to create, modify and refine your Frames without having to create the 
Frame HTML manually.

LOCATION: Snaglets    Frames

FEATURE:

USAGE TIPS:





Tools

The Tools menu option contains a lot of the heavy duty features in HotDog. Take note of the 
following,

· That the default shortcut key for locating the Tools menu is ALT+l
· That the default shortcut letter for locating a particular option in the Tools menu are to the 

right of the Ctrl option.
· That any Tools menu option marked “Yes” in the dialog box column indicates an associated 

dialog box.

Name Ctrl Letter Dialog Box
Options O Yes
Shortcut Keys S Yes
Customize Toolbars Ctrl+Alt+C z Yes

Make Template From Document T Yes
Create Template Field C Yes

Find Duplicate Links F Yes
Remove Hypertext Links R
Remove HTML Tags H
Check HTML Syntax Ctrl+H e

Multi-File Find and Replace M Yes
Spell Check p
Real-time Output Viewer i
Convert to HTML n
Upload to Host U
Mixing Desk x



Options

DESCRIPTION:
The Options screen gives you a great deal of control over how HotDog works. There are six sections:    
Each section has numerous options that you can modify and change.

LOCATION: Tools Options

FEATURE:
The options folder contains selections related to HotDog settings.

· General
· Editing 
· Publishing 
· Display 
· File Directories
· Saving/Starting 
· Color 
· Dictionary

USAGE TIPS:
When you change an option it will stay in effect until you make another alteration.    For example:    In 
the Start/Save tab, you can turn off the Animated splash screen to save time when loading.    The 
splash screen will stay turned off unless you go back to this option to turn it off.



Show ToolTips when mouse is over a button
When you hold the mouse pointer over a button on one of the toolbars for a few seconds, a yellow 
window will pop up with a brief description of what the control does. Check this box to disable this 
feature. If ToolTips are disabled, the information will appear on the Status Bar instead.

Drag & Drop from File Mngr opens file(s)
If this option is enabled, you will be able to drag files from the Windows File Manager or a similar 
program, and drop them somewhere in the HotDog window. HotDog will then open all the files that 
you dropped. Disabling this option may improve performance on slower machines. Note that if this 
option is disabled, you can still drag and drop files from the HotDog File Manager. 
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General

LOCATION: Tools    Options    General

FEATURE:
Always Use Absolute file references
Normally when you insert a file, HotDog tries to make its location relative to the current document. For 
example, if you're working on a document saved in the C:\HTML directory, and you insert an image from 
the directory C:\HTML\GRAPHICS, HotDog will create the hypertext link as 
HREF="graphics\animage.gif". If this option was enabled, then HotDog would insert the full path name, 
e.g. HREF="c:\html\graphics\animage.gif".

Always use Current Directory in File Dialogs
When HotDog shows a dialog for open, saving, or inserting files, it normally defaults to an 
appropriate directory as set in the File Directories options. For example, the documents directory for 
HTML files or the Graphics directory for images. If you have files spread all over your computer this 
behavior may become annoying. The Always Use Current Directory option will open the file dialogs to 
the current directory (normally the last directory they were in). 

Insert <P> on Elements Bar as a Container
The HTML draft suggests that the paragraph tag <P> is used as a container. However, this is not 
required by any current browsers. If you check this option, when you select the Paragraph button , 
HotDog will insert the </P> closing tag as well as the <P>.

Insert Text as Pre-formatted <PRE>
By default, HotDog Inserts Text Files as Pre-formatted text, using the <PRE> tag. Most browsers will 
display this in a monospaced font like Courier.        If you want to insert text files as a normal part of 
your document, you can disable this option to save you from removing the <PRE> tags manually.

Use a Fixed Name for Temp Files
This option is only required if you are having problems with the way documents are displayed in your 
browser when you Preview your documents.

HotDog communicates with browsers using DDE. When you choose Preview, HotDog will take a 
copy of the current document and instruct your browser to display it. By default, HotDog uses a 
unique file name for each copy, which forces the browser to load the document. 

If your browser does not support SDI standard DDE commands, then HotDog will start a new copy of 
the browser each time you choose preview. This can quickly eat up resources and slow down your 
system. To prevent this from happening, turn this option on. HotDog will start your browser the first 
time you choose Preview; after that, you will need to switch to your browser (for example by using 
ALT+TAB), and Reload the document (see your browser's documentation for instructions on how to 
do this).



Use Strong and Emphasis, not Bold and Italics
<STRONG> and <EM> are the preferred HTML alternatives to <B> and <I>. If this option is checked, 
HotDog will automatically insert these tags for you when you choose Bold or Italics from the Format 
Font.

Choose Browser before each Preview
If this option is checked, every time you choose Preview, HotDog will display a dialog to let you 
choose the browser you want to use. If it's not checked, HotDog will always use the default browser.

Publish Files for Previews
This option lets you Publish your files before previewing them. This has the advantage of always 
displaying the document as it will look when published, but some of the Publishing Options you use 
might not work properly for locally-viewed documents.

No Sound Effects
This option allows you to turn OFF the HotDog sounds.    You can edit the sounds using the sound 
mixing desk.

HTML Target Identifier
The current HTML 3 draft defines targets with the ID token. For example,

<P ID="contents"> will make a paragraph a target, with the name contents.

Previous versions of HTML used the NAME token in an anchor. For example, <A NAME="contents">

HotDog defaults to the first (HTML 3) method. If you prefer to use the older method, you can change 
the default target code in this box.

Big First Letter Size
This lets you set the size for the Big First Letter (drop caps) option. Sizes can be either relative (for 
example, +2) or absolute (for example, 5). Note that you can set a size smaller than the default font 
size, in effect giving you a "small first letter" option. We have no idea why anyone might want to do 
that, but who knows? If you find a use for it please let us know.



Show ToolTips when mouse is over a button
When you hold the mouse pointer over a button on one of the toolbars for a few seconds, a yellow 
window will pop up with a brief description of what the control does. Check this box to disable this 
feature. If ToolTips are disabled, the information will appear on the Status Bar instead.
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If this option is enabled, you will be able to drag files from the Windows File Manager or a similar 
program, and drop them somewhere in the HotDog window. HotDog will then open all the files that 
you dropped. Disabling this option may improve performance on slower machines. Note that if this 
option is disabled, you can still drag and drop files from the HotDog File Manager. 



190696
Do I include this ???

Show ToolTips when mouse is over a button
When you hold the mouse pointer over a button on one of the toolbars for a few seconds, a yellow 
window will pop up with a brief description of what the control does. Check this box to disable this 
feature. If ToolTips are disabled, the information will appear on the Status Bar instead. 

Drag & Drop from File Mngr opens file(s)
If this option is enabled, you will be able to drag files from the Windows File Manager or a similar 
program, and drop them somewhere in the HotDog window. HotDog will then open all the files that 
you dropped. Disabling this option may improve performance on slower machines. Note that if this 
option is disabled, you can still drag and drop files from the HotDog File Manager. 



Editing 

LOCATION: Tools    Options    Editing

FEATURE:
Document Font Name
This lets you control the font used for editing documents.

Document Font Size
This lets you control the size of the font used for editing documents.

Color tags after nn seconds idle (60 sec. max)
If this option is enabled, HotDog will display HTML tags in a different color from the rest of the document. 
Different tag types, for example Netscape or Microsoft tags, will be displayed in a different color from 
standard HTML tags.

HotDog waits nn seconds after you finish typing before going through your document to change the 
tag colors. If you have a slow computer, or you are working on large documents, you will probably 
want to set this to a fairly high number, e.g. 30, so that HotDog does not interfere with your work.

Quick Color (color on screen tags)
Choose this option if you want to update your document immediately.      As you type HotDog will 
refresh the screen and update in the process the on-screen attributes.    For example, say you have 
the,

Background default Blue

Foreground default Yellow

Default HTML Tag Color White

HTML Tag type HTML 3

HTML Tag color Red

If you type in the <Center> tag, immediately after you have placed the Tag in HotDog will refresh the 
screen, the <Center > tag in red.

Convert Extended Characters while typing
This option is designed primarily for European users. If it is enabled, whenever you type an extended 
character like an umlaut or acute, HotDog will automatically translate it into the appropriate HTML 
code (for example, &euml;). If you don't want this to happen while you're typing, HotDog can also 
translate all extended characters when you publish your document.

HotDog might take longer to process keystrokes if you use this option.

Tags in lower case
If this option is enabled, any tags HotDog inserts will be in lower case. HotDog will not automatically 
convert tags you type into lower case.



Floating windows activate when mouse points at them. (e.g. Tags, Chars)

Default Document Extension
The default document extension allows you to select either HTM or HTML for the default document 
extension.



Show Paragraph Marks (Pro version)
This option will display a character to mark every hard return in your document.

Show Spaces (Pro version)
This option will display a character to mark every space in your document.

Tab Indent (Inch)
Specifies the space (in inches) that HotDog will insert whenever you hit the Tab key.

Undo Depth (Pro version)
Tells HotDog how many previous actions to remember for the multi-level Undo function. HotDog can 
remember up to 99 actions; the default is 10. The higher this number is, the more memory HotDog 
will use.



Color Tags Now Process

DESCRIPTION:
HotDog will now display tags in a number of different colors.    We’ve built in support for tags that are 
not yet part of the official HTML standard, for example HTML 3 and the Netscape extensions to 
HTML.        Using the Color Tags Now feature,    Netscape, Microsoft, and HTML 3 tags can now be 
made will show up in different colors from HTML 1 and 2 tags. Naturally, this feature is fully 
customizable, so you can select your own colors and create your own tag groupings.

LOCATION:
The background reality checker comes in two parts,
1    Define the Background, Foreground text color & Link color,    Tools OptionsColors

2    Then update the screen,    Edit ColorTagsNow

FEATURE:
You can visually identify different tags by color.    But let’s get one thing straight, Tag color 
customization will not produce colored text for Web pages!        Being able to identify tags onscreen 
The real work is done in the in this Dialog box , if you go to the color folder you can set the on-screen 
attributes of,

· Screen color,    Foreground & Background.
· Default HTML Tag color
· HTML Tag type
· HTML Tag color.

USAGE TIPS:
1  To customize the colored tags follow these steps,

· Change options for Tag type & Tag type color (Example).
· But I can’t find out where to change the options?
· Color tags,    now.

2    In order to assign colors to your tags you have to go through a two stage process.    First go to the 
Tools OptionsColor      menu to select which tags and what color you want them to appear.    Then 
to apply the changes (ie: Color the tags) you have to go to the Edit ColorTagsNow option.

3    You can also alter the speed at which HotDog refreshes the screen    Tools OptionsColors



Publishing 

DESCRIPTION:
These options let you make some automatic changes to your documents when you Publish them.

LOCATION: Tools    Options    Publishing

FEATURE:
Remove All Carriage Returns
A Carriage Return/Line Feed is generated whenever you press Enter. Carriage Returns are useful for 
laying out your source document, but when it gets on the Internet it may cause problems with some 
browsers. You should use Line Breaks <BR> or Paragraphs <P> instead. This option will remove all 
Carriage Returns entirely.

Publish as UNIX Text File
This will convert all Windows text files to UNIX ones when publishing. Windows and DOS text files 
use the Carriage Return/Line Feed combination (CRLF) at the end of each line; UNIX files only use 
Line Feeds (LF).

Convert Extended Characters to HTML Codes
This option will automatically translate extended characters like acutes and umlauts into the 
appropriate HTML code (for example, &euml;). HotDog can also translate all extended characters 
automatically while you're typing. Note that HotDog will not replace ampersands (&) with &amp;. This 
is to allow you to specify extended characters manually.

Replace \ With / in File Names
This will convert Windows file references for use on UNIX systems. For example, 
HREF="graphics\animage.gif" would be replaced with HREF="graphics/animage.gif"

Extension For Published Documents
HotDog will save published documents to the Publish directory, as specified in File Locations. By 
default, HotDog renames these documents with the extension .PUB. This is to remind you to rename 
them as .HTML when you upload them to the Internet. If you do not like this behaviour, you can enter 
any valid DOS extension in this box.

Replace Words During Publishing
HotDogs Replace Text List (see below) is a very useful feature, but there are times when you do not 
want to scan the entire document for text to replace. This option lets you disable and re-enable the 
Replace Text List without deleting all the items in the list.

The Replace Text List
When publishing, HotDog will replace any text listed in the Replace column with the appropriate entry 
in the With column. For example, you can replace {home} with http://www.sausage.com, or .htm 
with .html.



Because this only gets changed when a document is published, you can use this feature to design 
site- and directory-independent documents. For example, instead of referring to your copyright page 
as HREF="/home/web/copyright.html" in all of your other pages, you can use something like 
[copyright page]. If the name or directory of your home page changes, you only need to change the 
entry on this screen, rather than in every single document.

The replace process is case sensitive. There is no limit to how many entries you can have, but 
HotDog will take longer to publish documents if you have a very large number.

USAGE TIPS:
Some text boxes have been added to help you add text to the grid controls that HotDog uses in 
various places. ie Words to replace when Publishing, Multi-File find and replace and What's New. 



Display 

DESCRIPTION:
These options give you some degree of control over HotDog's display.

LOCATION: Tools    Options    Display

FEATURE:
Document Display Options:
Word Wrap
Turn this option off if you have very long lines in your document, and you do not want HotDog to reformat 
them to fit in the screen. This option will have no effect on your HTML file; it is just provided to help you 
edit documents. If you want to prevent word wrap in your HTML documents, use the <PRE> tag. 

ROVER Display Options:
Refresh ROVER after nn seconds idle (max 60s)
Using option refreshes ROVER.      If you make a change inside HotDog and have ROVER running at 
the same time the time between making a change in HotDog and the changes showing up in ROVER 
is the amount of time in seconds you set (nn).    A good time delay is one second.    This means as 
you make changes in HotDog, the same changes are (almost) simultaneously being made in 
ROVER.

Refresh ROVER when document is saved
However what if the document is big?.    Using the last option will take time to refresh ROVER.    This 
option allows you to refresh ROVER only when you save the file.

Show Main Toolbar As:
If you fool around with these options you can change the combinations of text & button types as well 
as icons.    Don’t forget to use the “Apply key” to view the changes made to your selection without 
having to save them.
Icon & Text
If you want both the Icon and text to appear on the main Toolbar.    When this option is set each 
button on the main Toolbar will show it’s icon & text.

Icons Only
If you only want icons only to appear on the Toolbar. This means only the icons will appear. No text 
will appear with the associated icon.

Text Only (Narrow Buttons)
If you only want text only to appear on the Toolbar. This means only the text will appear.    The 
buttons will be narrow.

Text Only (Wide Buttons)



If you only want text only to appear on the Toolbar. This means only the text will appear.    The 
buttons will be wide.



File Directories 

DESCRIPTION:
This screen lets you tell HotDog where to look for files.

LOCATION: Tools    Options    File Locations

FEATURE:
Preview Browser
The default browser. This will be loaded when you choose Preview Document from the File Menu.

When you set the default browser, HotDog will change the icon on the Preview button to the browser's 
icon. This lets you quickly see which browser is the default.

If you want to test your document with a number of browsers (always a very good idea), you can set 
the Choose Browser before each Preview option. 

Documents
The location of your HTML documents.

Published Files
The directory to store published files, ready for uploading to the Internet. 

Graphics Files
The location of your image files.

AutoSave Files
The directory to store automatically-saved files in. 

Templates
The location of the Normal (default) template in HotDog Standard, and for all templates in HotDog 
Professional. 



.INF Files
INF files are used by HotDog for configuration information.      You can manually edit this file to 
change the settings in HotDog.    If you do, make sure you make a copy of the file.

Temporary Files
The location to store any temporary files HotDog creates. These will normally be deleted when you 
exit HotDog.

USAGE TIPS:
By default HotDog forces all file names into lower case (not the directories, just the file itself).    This 
makes it easier when putting web sites from case-insensitive Windows machines to case-sensitive 
UNIX boxes.



Saving/Start

LOCATION: Tools    Options    Saving/Start

FEATURE:
Auto-save every xx Minutes
Specify how often you want HotDog to automatically save your files for you. Files are saved into the 
AutoSave directory specified in File Directories with the extension .HDB.

Show Handy Hints when HotDog Starts
By default, HotDog will display a handy hint every time it starts. This can be switched off by checking the 
Get Rid Of These Things! box on the Handy Hints screen, and can be switched on and off from the Show 
Handy Hints option.

Create Backup Files when saving
By default, HotDog creates a .BAK file before it overwrites any existing files when saving or 
publishing. This option will disable this behavior.

Restore Last Session When HotDog Starts
If this option is checked, HotDog will remember the size and position of all open windows when it last 
closed. When HotDog next starts, these documents will be opened and arranged accordingly.

Note that whether or not this option is selected, HotDog will remember the positions of the Tags and 
Special Characters lists.

Open New Document When HotDog Starts
By default, HotDog will always start with a blank document open. If you do not want this to happen 
then disable this option.

Refresh Browser preview on saving document
If you have a large document you don’t want ROVER updating every time you type a word or every 
60 seconds.    It’s time consuming.    By refreshing the document only every time you save a 
document time you trade refreshing ROVER and having exactly what you have on the screen for 
SPEED!.

Skip animated splash screen on start-up
Do you want to save time loading up the program?    This switch turns off the “pretty” start-up screen 
and saves time.



Color 

LOCATION: Tools    Options    Color

FEATURE:
Background Color
Specifies the background color in the editing window.

Foreground Color
Specifies the foreground color in the editing window.

Default HTML Tag Color
Specifies the color that standard HTML tags will appear in if the colored tags option is set. 

HTML Tag type
Gives you a choice of HTML 3,    Netscape or Microsoft tags.    Used in conjunction with the “HTML Tag 
Type Color”.    Tag type refers to one of the three major tag standards being used on the Web.    If you use 
a tag, (say a Netscape tag, assign HTML Tag Type Color to red).    When HotDog refreshes the screen all 
the Netscape Tags will be RED.

HTML Tag Type Color
These let you assign colors to particular tag types. HotDog ships with some pre-defined tag types, for 
the Netscape and Microsoft extensions.      You can also create your own tag groupings in the Edit 
Tag Information screen.



Dictionary

DESCRIPTION:
These options apply to HotDogs Spell Checker. 

LOCATION: Tools    Options    Dictionary

FEATURE:
Customary Dictionary (Pro version)
The custom dictionary stores any words you choose to add to the spell checker. HotDog can use existing 
custom spell-check dictionaries created by Word or other Microsoft products.

Standard Dictionary (Pro version)
This is the location of the default dictionary for HotDogs spell checker. HotDog ships with the American 
English dictionary, but UK English, German, and French dictionaries are available from our Web site. 



Tools Shortcut Keys

DESCRIPTION:
HotDog Pro lets you assign menu commands to keystrokes. Choose the combination of CTRL, ALT, and 
SHIFT (use as many of these as you like) and the key you want to use, then pick the HotDog function 
from the list.    Functions are based on their menu names.

LOCATION: Tools    Shortcut Keys

FEATURE:
1    You can create your own shortcut combinations (HotKeys).

2    Whenever a key combination (that you created a shortcut for) is pressed; HotDog calls the 
appropriate function. 

3    Be aware that you cannot create certain shortcut keys.    A document editing Window (this could 
be any application) responds to certain shortcut keys regardless of what other function you define 
for that keyboard combination.    (CTRL+v will always paste)

4    To create a shortcut,    go to the shortcut column and press the key combinations that you want to 
be the shortcut.

5  The Delete button removes any previous shortcut keys created.

USAGE TIPS:
There are certain keyboard combinations that are pre-defined and should not be used (CTRL-ALT-
DEL).    When you create your short cut keys have a good look at the Windows standards for shortcut 
layouts.    Take a look at HotDog and other programs to see what key combinations are not used.



Customize Toolbars

DESCRIPTION:
The Customize Toolbar option let’s you create your own toolbar combinations.

LOCATION: Tools Customize Toolbars

FEATURE:
1    There are several default toolbars, ( You can turn them off,    delete them, create your own.    You 

do not have to use them at all.)
· Common Commands 
· Default
· Default2
· Tags
· Your Text

2    You can create or delete    a Toolbar.

3    You can add or delete buttons from the Buttonbar.

4    For any toolbar you can add or remove a button.

5    You can assign any of HotDogs 83 functions to a toolbar.    You can have a maximum of 10 
buttons on a toolbar.    You can have as many toolbars as your system requirements dictate.

USAGE TIPS:
1    A quick way to access the customize Toolbar dialog box is to,

· Position your mouse on the Buttonbar.
· Right click on your mouse.
· The customize Toolbar Dialog box should appear.

2    When you use the Toolbar and you want to know the,
· Toolbar name:      Go and have a look at Toolbars on the menubar.    Check for the toolbar 

name (Current toolbar is ticked.)
· Toolbar button name:      Place you mouse over the Button.    You will notice the name of 

the button will appear in two positions, the bottom left hand corner of the screen and 
(depending on the orientation of the toolbar (horizontal only) the top of the floating toolbar.



Make Template From Document

DESCRIPTION:
HotDog Professional lets you create templates. This is an easy way to give all your documents a 
similar look and feel, or to include common information in each one.

LOCATION: Tools    MakeTemplateFrom Document

FEATURE:
1    To use a template, select FileNew. A list of all available templates will be shown. Choose one 

from the list and press enter or click OK.

2    If there is no file called NORMAL.TPL in your Template directory, HotDog will create one.

3    To change the Normal template, simply replace the file NORMAL.TPL with the template you want 
to use as the default.

USAGE TIPS:
To create a template, design the file you want to use as a template in the editing window. Then 
choose, “Make Template”    from Tools Make Template from Document.    The document will be 
saved in whatever directory is specified for templates in the Options screen.



Create Template Field

DESCRIPTION:
This screen lets you create fields that will be automatically updated when you create, save, or publish 
your documents. These fields can insert information about your system, the current file, date and time, or 
read information from a text file. 

LOCATION: Tools    Create Template Field

FEATURE:
1    When you use this option you have to ask yourself the following question,

When do you want this field to be replaced with information?
      You can select one of two possible options,

· When a document is created from this template

· Each time the Document is Published.

2    After you make this selection, the program will automatically guide you through any options you 
need to make.

USAGE TIPS:
HotDog provides a number of automatically updated functions including,

· Date, 
· Time, 
· HotDog Version, 
· Current File Name, 
· Windows Version,
· HotDog Registered Company 
· HotDog Registered user.



Find Duplicate Links

DESCRIPTION:
This option will search for duplicate hypertext links in the current document. 

LOCATION: Tools    Find Duplicate Links

FEATURE:
1    If you have more than one link pointing to the same place, HotDog will alert you. Note that it's 

quite acceptable to have several links to one place in the same document; for example, you might 
have several references to your home page or a Table of Contents.

2    A dialog box will appear only when there is a duplicate link. 

USAGE TIPS:
You will only see the dialog box if you have a duplicate link.



Remove Hypertext Links

DESCRIPTION:
This option will remove any hypertext links selected text in a document.

LOCATION: Tools    Remove Hypertext Links

FEATURE:
1  If no text is selected, HotDog will ask you if you want to remove all the links in the document.
2    Can remove Hypertext links in a specific area.

USAGE TIPS:
1    All hypertext links will be removed when you use this function.    If you try to undo    remember, 

· Only the last change you have made is restored.
· This means any links before the last link will be unrecoverable! 
· The only way to recover a mistake if you have made more than one change is to load the 

last saved file. 
· Save early, save often!

2    If you want to remove hypertext links in a specific area of a Web document, highlight the area of 
text using your mouse then use,    Tools    Remove Hypertext Links



Remove HTML Tags

DESCRIPTION:
This option will remove any HTML tags from selected text in a document.

LOCATION: Tools    Remove HTML Tags

FEATURE:
1  If no text is selected, HotDog will ask you if you want to remove all the Tags in the document.
2    You can remove Tags in a specific area within your Web document.

USAGE TIPS:
1    All Tags will be removed when you use this function.    If you try to undo    remember, 

· Only the last change you have made is restored.
· This means any links before the last link will be unrecoverable! 
· The only way to recover a mistake if you have made more than one change is to load the 

last saved file. 
· Save early, save often!

2    If you want to remove Tags in a specific area of a Web document, highlight the area of text using 
your mouse then use,    Tools    Remove Hypertext Links



Check HTML Syntax

DESCRIPTION:
This handy little tool can save both time and effort by diligently searching through reams and reams of    
HTML code.    No matter how messy or badly laid out, the Syntax checker will seek out, that hard to find 
glitch.

LOCATION: Tools CheckHTMLSyntax

FEATURE:
1    You can check what errors that have been detected.    The error compiler indicates what HTML 

syntax errors have occured.

2    There are three options you can use,
· All warnings: Will show all warnings encountered.
· No language warnings: Will not show any language warnings encountered.
· No warnings: Will not show any warnings.

3    All the different flavors of HTML have a strict set of rules,    the syntax checker looks for,
· Mistakes in the HTML syntax.
· For example:    An error will occur if you have the following,
· <H1>………That’s all folks…….
· By not putting in the matching closing tag, </H1> an error will result.

USAGE TIPS:
1    Get into the habit of using our syntax checker just after you save you document.

2    If you want to use the syntax checker,
· Go to Tools CheckHTMLSyntax
· Select the Check HTML Syntax option.
· Hey presto…that’s it!    Your code will automatically be checked to see if it’s 100% HTML.
· A small window will appear on your display to inform you of success.

3    The syntax checker will not look for spelling mistakes!!



Multi-File Find and Replace

DESCRIPTION:
This function lets you find and replace information in a number of different HTML files at once.

LOCATION: Tools    Multi-File Find and Replace

FEATURE:
1    Caution:

This is a very powerful feature. It can make your life much easier, but it also has the potential to 
do a lot of damage if you make a mistake and replace the wrong thing.

2    Replace ALL:
Search & replace several items at once at the same time.

3    Choose files:
Through dragging or typing).

4    Find ALL:
Use the “Find All” button to find, select, open files that meet the search criteria.

5  Document conversion:
Option to do batch conversion of ASCII files to/from the UNIX format.

USAGE TIPS:
1  We strongly    recommend that you make backups of all files you want to replace before using this 

function.

2    If you do make a mistake using find & replace, try using this tool to replace the text you replaced 
with the correct insertion text.



Spell Check

DESCRIPTION:
“…and so I sayed to thiis chappy…”
Do notice something odd about this line?        Yes, SPELLING ERRORS!    but don’t worry, you          need 
not suffer from the curse of the atrocious speller again.    HotDog Pro ships with the US - English 
dictionary. Dictionaries for other languages are available from our Web site

LOCATION: Tools    SpellCheck

FEATURE:
The spell checker will go through all your selected text and hunt down spelling errors.    When an error is 
encountered the Spell checker dialog box will appear.    You can choose to use the following, 

1    Suggestions:
Will prompt a selection of default alternative words. You can Ignore/replace.

2    Ignore:
Proceed to the next suspect (possibly incorrect spelling) word.

3    Replace:
Replace the misspelled word with a correct word available from the list. 

USAGE TIPS:
What does Spell Check look for ?

· The Spell Checker looks for the correct spelling of    text within the HTML code.
· The following would alert the spell checker,

<HEAD>

<TITLE>…Takee good care of my kite Lad…</TITLE>

</HEAD>

· Spell Checker, ignores HTML syntax.    Anything within the “<…>” is ignored.



Real-Time Output Viewer

DESCRIPTION:
The ROVER window has now become a mini-WWW browser.    You can use it to cruise around the Web 
and if you find a page like, and you’re curious as to what HTML they used then just click on the “Open In 
HotDog” button to transfer their page straight into a HotDog document.    There is also a Width checker 
which you can use to see how your page will appear to users who’s computer monitors are configured to 
640x480, 800x600 or 1024x768 resolution.

LOCATION: Tools Real-timeOutputViewer

FEATURE:
ROVER now has the following features,
1    Net Aware and can be used as a functional web browser.

2    View a Web page in ROVER then see the Web page source.

3    Insert Web page source straight into HotDog.

4    View Web documents in ROVER    in several screen resolutions.

USAGE TIPS:
1    ROVER won’t display every non-standard tag you may want to use, but it certainly won’t stop you 

from using whatever tags you want to. Of course, you can still preview your documents using 
another browser. In fact, we strongly recommend it!

2    An option has been put in to make ROVER update whenever your current document is saved.    
This is the way I work - it feels right :-).

3    Also ROVER will change to reflect whatever document you have selected, so as you toggle 
through multiple documents it will show you what each one looks like, unless you click on the 
"Lock" checkbox in the ROVER window.



Convert to HTML

DESCRIPTION:
Got a whole stack of ASCII text files you want to turn into web pages?      Our HTML Converter will 
faithfully chomp away and convert them to HTML.    You do need to give HotDog some basic instructions 
(described below).    The Converter will then follow your orders on how you want your ASCII files to end 
up and translate them into a Web document.    Sit back and let the HTML Converter do all the hard work 
for you.

LOCATION: Tools    Convert to HTML

FEATURE:
The Text to HTML Converter is divided into four areas.      Changes can be made in the following 
areas,

· Formatting Paragraphs
· Formatting    Isolated Lines
· Leaving text in the same format
· Formatting End of Lines



What are the options to use in Convert to HTML?

DESCRIPTION:
The Text to HTML Converter is divided into four areas.    In each of these areas, options you can choose 
from are,

Formatting Paragraphs
· Convert line(s) into plain text paragraphs by inserting a “<P>” tag.
· Create a list, bulleted or numbered.
· You also have the further option to remove/leave lists.

Formatting    Isolated Lines
What about isolated lines ?

· You can add newline tag “ <BR> ” for the first or other individual lines.
· You can also insert a blank line in relation to the above.
· There are several options: above,below…etc.

Leaving text in the same format
What does Area 3 do ?

· Inserts a “ <PRE> ”    tag that leaves text as it is.    Eg: Lines of pre-formatted text will not 
change.

Formatting End of Lines
What does Area 4, End of line's do ?

· At the end of a line insert a newline tag, <BR>.
· Preserve a body of    text with any number of lines.
· Option:    Insert the number of lines for a paragraph.
· Paragraphs will be maintained for the number of sequential lines chosen above.

Eg: Select 4.
Result: Paragraphs will made for 4 or more sequential lines.



Upload to Host

DESCRIPTION:
HotDog's Auto-Upload feature makes it easy for you to upload your documents to your web site. 

LOCATION: Tools    Upload to Host

FEATURE:
1    HotDog will connect to your web site and automatically upload the current document, as well as 

any images and local files it references.

2    The next time you want to use Auto-Upload, just click the Upload button and the process will 
begin immediately. If you ever want to change your login details, you can do this from the Tools 
Options WebServer screen.

USAGE TIPS:
To use the Auto-Upload features,

· Make sure you are connected to the Internet. 
· Once you have logged on, just click the Upload button on the Button Bar.
· The first time you use Auto-Upload, you will be asked to provide some information about 

your web site. 
· Fill in the screen with information provided from your ISP.
· Then Click OK. 



Default Web Server

Directory On Server

Default Login Name

Password



Mixing Desk

DESCRIPTION:
The Sound Mixing Desk allows you to assign random sounds to any of the 83 different functions found 
within the program.

LOCATION: Tools    Mixing Desk

FEATURE:
How about putting the fun back into editing?    With the Sound Mixing Desk    you can,

1    Assign a sound to a HotDog function or HotDog event.      Every time a function or event is called, 
the assigned sound will play.
HotDog Function Based
You use HotDog functions all the time.        A function changes/manipulates data (web document). 
An example of a HotDog function is the Tools Mixing desk, FileNew or    EditSelectAll.
HotDog Event Based
An event is related more to system type operation on data (Web document).    An example of 
HotDog based event is,    Toolbone Click (When you press a toolbone: Sound clicks. )

2    You can also Add or Remove a sound from the playlist.
Add sound:      Allows you to choose a sound file from your system & copies the file into playlist.
Remove sound:      Removes a sound from the playlist.

3    Use a sound Pack.
Sound Pack notes:      A sound pack is a sample of sounds we have put in so you can play with 
some sounds.

4    You can even choose how often a sound will play with the Playing frequency.
Play Sound Every Time:      A sound will play associated with either the HotDog event or function.
Only play sound nn% of the Time:      Will play a percentage of the time where nn is percentage 
of time the sound will play.

5    Randomly assign a sound to an event or function.
Randomly choose One of These Sounds:      Will randomly select a sound from the playlist    
and play this sound for any assigned event or function called

USAGE TIPS:
How do I turn the sound off?      Go to Tools    Option General and,

· Move your mouse to No Sound Effects
· Turn the tick off .
· That’s it.



300596
Work:

Started Window
Q Is it good for the user to have directions to where the features are on the menubar?
Check if the Tile opens all, especially if ionized.    It does not appear so!
What do you mean by default?



Window

The Window menu option contains all the HotDog operations related to the Windows your Web 
documents appear in.      Take note of the following,

· The default shortcut letter for locating a particular option in the Window menu located are to 
the right of the option name.

Name Letter
Cascade C 
Tile T
Arrange Icons A
Close All l

Window List



Cascade

DESCRIPTION:
The Cascade option applies to all web documents (in their respective windows) that are currently open. 
Cascade, re-arranges the windows in your work area much like a when you hold a hand of cards.    Open 
files, appear stacked one on top another in an 45 degree isometric fashion.

LOCATION: Window Cascade

FEATURE:
Using this option,

· Re-arranges the way your files appear on screen.
· Will display all Windows currently open, stacking Window upon Window, from left to right, 

bottom to top.

USAGE TIPS:
1    Try this option to better organise your workspace.

2    You can quickly tell by looking what Web document you last worked on,    by looking at the order 
of the cascaded Windows.



Tile

DESCRIPTION:
The Tile option applies to all Web documents (in their respective windows) that are currently open.    
Tiling your screen re-arranges the windows in your work area by re-sizing the currently open windows so 
they all fit geometrically on your current workspace.    Tiling, as the old saying goes “comes in any shape 
as long as it’s rectangular!”.

LOCATION: Window Tile

FEATURE:
Using this option,

· Re-arranges the way your files appear on screen.
· Tiling allows you to view all your currently open Web documents at once.

USAGE TIPS:
1    For readability,    four files tiled at any one time is a good rule of thumb.    Unless of course you 

have 21’’ monitor and keen eyesight!

2    The Tile option will only tile files that are maximized.    For example, if one file is minimized and 
two other files are maximized, using the tile option will result in tiling the two maximized files only.



Arrange Icons

DESCRIPTION:
The Arrange Icons option expands or collapses the current work Window you are using into a small 
square icon at the bottom of the page.

LOCATION: Window ArrangeIcons

FEATURE:
1    Using this option,

· Re-arranges the way your files appear on screen.
· Arrange Icons,    reduces the currently used window to an icon at the bottom of your work 

area.

2    The iconized representation of the file consists of a HotDog Icon, file path (chopped) and the 3 
default Windows system buttons.



Close All

DESCRIPTION:
The Close All option allows you to close all currently opened Web documents in go.

LOCATION: Window CloseAll

FEATURE:
Using this option,

· Will close all files that appear on-screen in one go.

USAGE TIPS:
Don’t use this option if you haven’t saved your work.    It might be a obvious comment to make but it 
only takes one click to zap all your work.



Window List

DESCRIPTION:
The Window List shows all the currently opened files and indicates which file is currently being worked 
on.

LOCATION: File
Edit
View
Window

FEATURE:
Lists the,

· Currently opened files
· Their file paths.
· Order of opening files.

USAGE TIPS:
You can check the currently opened file and it’s path by looking for the small tick to the left of the file 
name.





290596
Work:

Worked on all links
Assigned macros to the following.

Contents Search()
Search HelpOn()
HTML Reference JumpContents(“HTML.hlp”)

Change name of Html.hlp file to HTML.hlp
Emailed Brian, “What’s Memory load ?”
Q Should I have a back macro in the HTML helpfile?



Help

The Help menu option contains all the HotDog operations related Help file associated with HotDog.    
Take note of the following,

· That the default shortcut key for locating the Help menu is ALT+H
· That the default shortcut letters for locating a particular option in the file menu are to the 

right of the shortcut
· That any file menu option marked “Yes” in the dialog box column indicates an associated 

dialog box.

Name Letter Dialog Box
Contents C
Search S
HTML Reference H
Registering HotDog R
About HotDog A Yes



Contents

DESCRIPTION:
The Contents option calls up the first page of the Help file.

LOCATION: Help Contents

FEATURE:
The HotDog Help file has been designed specifically for several types of learning,

· Show me the big picture.
· Show me all the intricate, nitty gritty.
· I can’t be bothered learning everything,    I want an answer NOW!

USAGE TIPS:
1 The “Big Picture” learner

If you want to get a feel of how HotDog, Tags, HTML and the Web relate together then use the 
Help file in the following order,

· Follow the Help file through “as is”.
· Skip any specific topics until you are ready. 
· Read about exactly what HotDog is capable of.
· Read about HotDog related concepts such as tags, HTML, the Web
· These topics are covered in the Help file,    HotDog & HTML help file’s

2 The “Detail learner”
If you want to systematically learn about some aspect of HotDog or get right into a specific topic 
then do the following,

· Topic
Select the topic you want to learn about from the index button
It’s found second button from the left, next to the contents button.
· Menu
Go to the Menu’s in the Menu’s section of HotDog Help.
It’s title is “A detailed look at HotDog” 
It can be located in the index by typing it’s title or “detailed”, “comprehensive”
· Tutorial

Search through the tutorials and see if there is a tutorial you can work on.

3 Give me an answer NOW!!!!!!!
There is always a time when you haven’t got time to do the “detail thing”.      You might even 
know the big picture,    so you don’t want to waste any of your precious time reading verbose 
passages of text without getting results fast. 

Try using the index.



Search

DESCRIPTION:
The Search option invokes the search engine.    Your ability to find a specific item is greatly enhanced 
using this tool.

LOCATION: Help Search

FEATURE:
The search engine allows you to find what you want in the Help file by searching for,

Contents: Searching through a graphical tree of topics
Index Searching through indexed keywords & topic headings
Individual words Search for individual words

USAGE TIPS:
1  If you want some help on “how to get the best out of using the Help system”,  then    check out 

the dreaded Help on Help.

2    Searching for information can be frustrating if you can’t find what you want.    This help file has 
attempted to have a base amount of information on every feature and most concepts related to 
HotDog.    Have a look at the structure and become familiar what type of information is available in 
this Help file.

3    If you really feel there are some gaps in coverage then let us know!



HTML Reference

DESCRIPTION:
HTML Reference is a library of HTML codes.    If you want to know more about,

· HTML Specifications.
· Netscape Enhancements to HTML.
· Microsoft Enhancements to HTML.
· Quick Reference guide to HTML.
· More about tags in general.

then look no further.

LOCATION: Help HTMLReference

FEATURE:
1    The HTML reference library has been created as a separate Help file,    HTML helpfile, 

(HTML.hlp).    When you go to this reference notice,
· The title of the Help file changes
· The color of the Help file changes

2    If you want to go back to the HotDog helpfile,
· Use the back button at the top of the Helpfile
· Use the Index to search for a new topic

3    For the user this means the latest version of the HTML file can be grabbed from our Web site 
without having to download the complete Helpfile again.



Registering HotDog

DESCRIPTION:
This option allows you to find the information necessary for registering HotDog or contact Sausage 
Software.

LOCATION: Help RegisteringHotDog

FEATURE:
1    To register your copy of HotDog or just contact Sausage the Sausage Help file has been created 

as a separate Help file,    Sausage help file, (.hpj).    When you go to this reference notice,
· The title of the Help file changes
· The color of the Help file changes

2    For the user this means the latest version of the HTML file can be grabbed from our Web site 
without having to download the complete Helpfile again.

3  If you see the  symbol you are in the Sausage Helpfile, (Sausage.hlp).



About HotDog

DESCRIPTION:
This screen displays version and copyright information about HotDog. It also gives you some 
information about your system resources,

· Memory load
· Available memory

LOCATION: Help AboutHotDog

FEATURE:
Memory Load

This feature is related to how HotDog is effecting system performance.    The higher the resource 
gauge, the more your system can handle memory load.    This function is also related to the 
Microsoft System monitor.

Available Memory
This is the amount of RAM (Random Access Memory) available to the system.
It includes,

· Virtual Memory as set in the 386 Enhanced Section of Windows Control Panel
· the System section for Windows 95 and Windows NT. 
· It is expressed in bytes (one Megabyte is a little over 1 million bytes).



Tutorials for HotDog

The following tutorials have been written to illustrate to a novice user the new features of HotDog32. 
You will notice that the examples are limited to the *new* features.    As time goes on more tutorials 
will be added,    highlighting specific areas aside from new features.      The tutorials listed below are 
specifically designed for HotDog32 and have been written with the following things in mind,

· Summary of the feature.
· Where is it located in HotDog.
· What’s it for.
· Give me an example.

TUTORIALS:
Using the Background Reality checker
Using ROVER
The Sound Mixing Desk
The Shortcut keys
Using Toolbars
Using Wildcards when opening files
Creating a Simple Homepage using HotDog



Finding HotDog menus & functions from the menubar
More Tutorials……… 



ROVER

Tell me about ROVER?
ROVER is HotDog32’s best friend.        Rover has changed a lot since HotDog 2.X.    He is now Internet 
aware.    Yes, Internet aware!    This means you can use ROVER as a browser call up Web pages and 
the like!    You can also use cool tools in ROVER such as the width-checker.    But more of that later.    If 
you want to know more about ROVER check the following, 

Where is ROVER?
ROVER can be found on the menubar.

What can I use ROVER for?
It’s possible in ROVER to,

· View URL’s
· Navigation of URL’s & Documents in ROVER
· View document source
· Insert document source into HotDog32
· Check different video screen resolutions

Give me some examples
To understand how you can use ROVER more effectively try the following,

· View a Web document you are working on.
· View a Web URL from the World Wide Web
· Insert HTML source into HotDog32
· Navigate Web document from the Web
· Use the width checker



I can use ROVER to view URL's

· Type in a URL of a Web site at the text input line.

· You should now be at a Web site



I can use ROVER to navigate

· You can navigate around using the hyperlinks on the page or 

· ROVER’s navigation buttons such the arrows & the stop button.



I can use ROVER to view documents

· ROVER uses the same technology used to create browsers

· ROVER is essentially a mini-browser.

· ROVER allows you to look at a Web page just like a browser.



I can insert a Web page with ROVER

· Best of all you can grab the Web page source HTML code.

· Then copy the source HTML code into HotDog32.



I can use different screen resolutions in ROVER

· The width checker simulates different screen resolutions. 

· Allows you to preview the current    Web page using standard video resolution modes.





Tooltip1 for ROVER

To locate ROVER use a right click of the mouse.



Tooltip2 for ROVER

Where is ROVER?    To find ROVER you can either,
· Go to the menubar, 

· Move mouse to Tools option.

· Move your mouse down the list 

· Select the third text item, “Real Time Output Viewer”.

Or by looking on the bonebar, 
· Go to that bone shaped object, the bonebar.

· It’s at the top of the screen above your work area.

· Select the ROVER graphic



Rover example: View Web document
Objective:
View a Web document you are working on.    To understand how you can use ROVER with a Web 
document try the following,

Loading the Web document you are working on.
· ROVER will not work until you load a file

· Save the current file you are working with

· Then press the ROVER button on the Bonebar

View it’s source
· Press the View Source button found in ROVER

View it as a Web document
· Press the View Document button found in ROVER

Use the Width checker
· Select the appropriate screen resolution & watch the change.



Rover example: View Web URL
Objective:
View a Web URL you are working on.    To understand how you can use ROVER with a Web URL    
try the following,

Type in the URL
· Enter the URL of your favourite Web location at the input box found in ROVER

· Eg: www.sausage.com.au

View it’s source
· Press the View Source button found in ROVER

View it as a Web document
· Press the View Document button found in ROVER

Use the Width checker
· Select the appropriate screen resolution & watch the change.

· Eg: Try selecting the 640 button.

· View it, then select the 1024 button.



Rover example: Navigation
Objective:
You can navigate while viewing a Web document or URL in ROVER.    To understand how you can 
use ROVER this way try the following,

Load a Web document
· ROVER will not work until you load a file.

· Save the current file you are working with.

· Then press the ROVER button on the Bonebar.

· At this stage enter two Web documents.

· When you do this a copy of the Web documents typed is inserted into ROVERS memory.    Really 
a combo box found to the right of the STOP button.

Or load a URL
· Enter a the URL of a favourite Web location into the input box found in ROVER.

· When you do this a copy a copy of the URL you typed is inserted into ROVERS memory.    Really 
a combo box found to the right of the STOP button.

Use the Left arrow
If you click the left arrow, 

· documents or URL’s currently loaded into ROVER memory can be viewed 

Use the Right arrow
If you click the right arrow, 

· documents or URL’s currently loaded into ROVER memory can be viewed 

Use the stop button
Pressing the stop button will halt any activity in ROVER.    This is primarily when you are visiting a 
URL & loading a Web page from the Internet.



Rover example: Insert HTML source into HotDog32
Objective:
While viewing a URL you are working on you can insert the source directly into HotDog32.    To 
understand how you can use ROVER this way try the following,

Load a URL
· Enter a the URL of a favourite Web location into the text input box (Combo box) found in ROVER.

· When you do this a copy a copy of the URL you typed is inserted into ROVERS memory.    The 
combo box found in ROVER to the right of the STOP button.

View Source
· Once you can see the Web page, press the, “view source” button.

Insert source into HotDog
· If you press the, “Open in HotDog” button the source will now be copied into you currently opened 

file



Rover example: Width checker
Objective:
At any time you are using ROVER you can change the screen resolution of ROVER.    Using this 
function ROVER simulates some common screen resolutions.    To understand how you can use 
ROVER this way try the following,

Load a Web document
· ROVER will not work until you load a file.

· Save the current file you are working with.

· Then press the ROVER button on the Bonebar.

· At this stage enter two Web documents.

· When you do this a copy of the Web documents typed is inserted into ROVERS memory.    Really 
a combo box found to the right of the STOP button.

Or load a URL
· Enter a the URL of a favourite Web location into the input box found in ROVER.

· When you do this a copy a copy of the URL you typed is inserted into ROVERS memory.    Really 
a combo box found to the right of the STOP button.

Change the screen resolution of ROVER
· Once you have a URL or Web document inside ROVER you can change the screen resolution.

· You do this selecting the various screen resolutions.

· The selections can be found along the bottom of ROVER.

· They include Original, 640, 800 & 1024.

· These values refer to the x co-ordinates of common windows screen resolutions.

· eg: 640x480 pixels.



Toolbar

Tell me all about Toolbars?
Toolbars are simply a way for a user to interact with HotDog32.      In HotDog32 we have 3 types of 
toolbars,    the menubar, the bonebar and the customisable floating toolbars.      This tutorial is all 
about customising the floating toolbars.      This toolbar allows you to create your own work environment 
by allowing you to decide what tools you want & in what combination you want them on your desktop.    
You have the ability to assign HotDog32 functions (all 83 of them),    your own tags and to top it off,      text.

Where is the Toolbar?
You can find this tool by,

· Going to the menubar,
· Move mouse to Tools option.
· Move your mouse down to the customise toolbars option.
· Select it.

What do I use the toolbar for,    how do I customise the Toolbars?
First you…Add the toolbar
To do this 

· Click the button of the same name
· Enter the name you assign to the toolbar
· Watch it appear.
· Click OK.

Then Add button(s) & assign your stuff to the button.
To do this,

· Click the button marked add button, there is a limit of 10.
· Then assign either an event tag or comment to the button.
· That’s it.

Give me an example
1 Create the toolbar

Add toolbar
· Press the Add toolbar button.

Add button
· Press the Add button, button.

Add function
· Select a function from the “Choose HotDog Command” box

· EG: OpenFile

Add an HTML tag
· First add another button

· Then select an HTML tag from the “Choose HTML Tag” box



Add some user defined text
· First add another button

· Then enter text into the “Enter your own text” box.

· Notice there is only 10 user defined tags.

· Select one.

Save the result
· Press the save button. 

· It’s found at the bottom of the customize button box

Close the customize screen
· Press the close button. 

· It’s found at the bottom of the customize button box

2 View the toolbar & use it
Select toolbar from menubar Toolbar option
· Go to the menubar & select the “Toolbars” option.

Select toolbar name
· Select the name you have given the toolbar

View the toolbar on the screen
· You should now see the toolbar you created .

· It    will have the OpenFile function you selected on it.

· In the form of a graphic.

Take notice of these things.
· You can find the name of a button by placing your mouse on it.

· The name will appear on the title of the toolbar if the toolbar is horizontal

· Or the name will appear on the browser status line of HotDog32 if the toolbar is vertical



Tooltip1 for toolbars

To locate it right click the mouse if your mouse is on the floating toolbar



Shortcut Keys

Tell me all about Shortcut Keys?
Shortcut keys are for those “power-users” but can also now be used by the rest of us.    The whole idea 
about shortcut keys is to have a keyboard combination that performs a certain function.    In HotDog32 
shortcut keys are all about YOU being able to make your own.    Instead of relying on the software you 
can now make your own quick cuts to perform a HotDog32 command.

Where do I customise the Shortcut Keys from?
You can find this tool from the menubar by,

· Going to the menubar,
· Move mouse to Tools option.
· Move your mouse down to the shortcut keys option.
· Select it.

How do I customise them?
Here’s how to do it,

· Select the shortcut keys option
· Point your mouse to the function you want in the left-hand column.
· In the right hand column enter in a key combination.
· Repeat this operation for any more keys you want to assign.

Give me an example
Before you do anything checkout the readme.htm file

Do this because Windows assigns certain keys and key combinations.    Be aware of what 
keys/ key combinations you should not use.    Don’t assign a shortcut key to F1 or 
CTRL+ALT+DEL for example.    If you do this funny things happen like F1 calls Help & 
CTRL+ALT+DEL reboots…..

Select the customise option.
You can find this tool from the menubar by,

· Going to the menubar,
· Move mouse to Tools option.
· Move your mouse down to the shortcut keys option.
· Select it.

Create the shortcut key
On the left hand side of the entry box. select the function, for example FilePrint.
On the right hand side of the entry box press the F2 button.
That’s it.    Now every time you press F2 your Web document will print



Sound Mixing Desk

Tell me all about the Sound mixing desk?
How about putting the fun back into editing?    HotDog32    has a new function called the Sound mixing 
desk.    Of course this will only work if you have sound-card in your system.    The sound mixing desk 
shows how that certain windows ..uh hum.. operating system should handle sound.    You can assign 
random sounds to any of the 83 different functions found deep within the bowels of the program.    
Every time that function is called the assigned sound will play.    You can even choose how often a sound 
will play - perhaps you would like to hear a sound but only 10% of the time!    Just to keep you on your 
toes….

Where do I customise using the Sound mixing desk?
You can find where to customize by,

· Going to the menubar,
· Move mouse to Tools option.
· Move your mouse down to bottom of this list to mixing desk.
· Select it.

How do I customise the sound mixing desk?
Select either a HotDog function or HotDog event.

· Do this be clicking one of the two buttons at the top of the form. 
· It wasn’t that hard was it?

Select a function.
· Move your cursor to the left hand side function box. 
· Select the function from the list.

Select a sound.
· Move your cursor to the right hand function box to select a sound. 
· Do this , select a sound. 
· You can also select no sound here.

Select an option. 
· You can select either a sound to play in 
· random manner 
· or the frequency of that sound. 

Give me an example
You can assign a sound to an HotDog event of function.    So we will try both.

Assign a new sound to an Event
When you use the Bonebar the growl sound will be heard.
Select the HotDog event
· For this example choose the HotDog event based option

Select the event from the big left hand box



· Choose    the Toolbone(Bonebar)click

Select a sound
· Move your mouse to smaller right hand box

· In this case select howl.wav

· You can see if it’s assigned by looking at the Current sound box.

Save the settings
· Press the save button at the bottom of the dialog box

Assign a new sound to an Function
When you open a new file HotDog32 attack sound will be heard.
Select the HotDog function
· For this example choose the HotDog function based option

Select the event from the big left hand box
· Choose    the FileName option.

Select a sound
· Move your mouse to smaller right hand box

· In this case select attack.wav

· You can see if it’s assigned by looking at the Current sound box.

Save the settings
· Press the save button at the bottom of the dialog box



Wildcards

Tell me all about using wildcards when opening files?
Wildcards are for finding files or groups of files using a “*” (star) to represent an unknown.    Back in the 
good old days of DOS command line operating systems you could find a file or series of files by inserting 
a wildcard.    With this feature you could enter incomplete information and search for an unknown file.    
For example if you know what the extension of a filename is but forgot the exact name.    You can search 
for all files with the extension of .htm, by typing *.htm at the command line prompt.

This concept has been kept up with Windows 3.1 and now Windows95.    So if you want to 
perform an operation on a group of files in HotDog32, as long as there is some common 
information in the filenames or extensions you can use wildcards.    As a general rule wildcards 
work with groups of files where it makes sense.

Where are wildcards are applicable?
As stated above, wildcards are used for system commands being applied to multiple files.    You 
can use wildcards wherever you open a file and where it makes sense.    If you try to open all 
projects in a directory using *.prj for example, nothing will happen.    The reason for this is you 
cannot open more than 1 project at a time.
 
How do I use the wildcard command?
The wildcard commands are subset of the old DOS operating system commands adopted from 
UNIX.    I will illustrate some common wildcard search’s you may want to try.    If you want a 
complete definition try checking these manuals out.    If you want a quick guide how to,

Open files with the same extension
Say you want to open all the files in your current directory with the file extension, “.htm”    You 
could do this manually one by one or you could enter at the Filename textbox, *.htm.    The 
wildcard ,“*” placed in this way (*.htm) can be interpreted as saying, “ open all the files in the 
current directory with the extension of .htm.

Open files with filenames partially the same
If you want to find all filenames that start with say “testxx.htm” you can use wildcards in 
another way.    This method is good for loading files that may have similar names.    For 
example if you had 5 files with the start of the file as testxx.htm and the filename after the test 
is something else eg: test1.htm, testqqqaadf.htm, test6.htm, you can use wildcards in this way 
to find all these files.    Eg: test*.htm.    In this example the wildcard search’s for all files in the 
current directory with test then anything after the test will be found. 

Open all files
Don’t try this one. You are only asking for trouble.    If you use this wildcard combination with 
the open command all files will open into HotDog. This includes text files as well as binary files. 
Although you can theoretically open up to 2 billion characters into HotDog, opening all files is a 
quick way to crash you system.



Give me an example
Open files with the same extension

· Go to the menubar.

· Select the file option.

· Move downwards and select the open option.

· A dialog box will appear.

· Move you mouse to the filename textbox found to the right of it’s name.

· Enter *.htm

· All the files with this extension will be loaded up.

Open files with filenames partially the same
· Go to the menubar.

· Select the file option.

· Move downwards and select the open option.

· A dialog box will appear.

· Move you mouse to the filename textbox found to the right of it’s name.

· Enter test*.htm

· All the files with this extension will be loaded up.

Open all files: (For those silly enough to try!)
· Go to the menubar.

· Select the file option.

· Move downwards and select the open option.

· A dialog box will appear.

· Move you mouse to the filename textbox found to the right of it’s name.

· Enter *.*

· All the files with this extension will be loaded up.



Background Reality Checker

Tell me about the Background Reality Checker?
The Background Reality Checker is a tool you can use to visually design the color of onscreen attributes, 
background, foreground, text or links.      Using the Background Reality Checker you can make sure you 
choose text colors that look great on whatever background you choose and make sure that your 
backgrounds are effective as well as attractive.    HotDog also offers you an Advanced Tiling Tool . The 
Advanced tiling tool will give you a preview of your background when its tiled across a web page.

Where is the Background Reality Checker?
Menubar:    Format Document Graphics/Colors

What can I use the Background Reality Checker for?
Specifically the Background Reality Checker allows you to,
1    Check how individual color selections effect each other for,

· Background color
· Document Text color
· Standard Link color
· Visited Link color
· Active Link color

2    Modify and control the color for the above using the 
Course color controls found on the Reality checker dialog.

· Slider RGB color control.
· Shades of grey.
· Change RGB values to decimal.
· Edit RGB color directly in HEX or Decimal.

Fine color control found when you click on the small color icon.      Select predefined or 
customize your own color. Ability to customize,

· Hue
· Saturation
· Luminosity
· RGB values

3    Miscellaneous:    Includes,
· Boldness button:      Compare what text looks like when bold or plain.
· RGB to Decimal:      Convert the RGB value from HEX to Decimal.    Allows you to 

edit/change either.
· Reload button:      Load previous background.

Give me an example



1.    Go to the Background Reality Checker, Format FormatDocument Graphics/Colors

2    Change the Background color by, 
Using the coarse onscreen method,

· Move your mouse to the sliders labeled Red, Green & Blue.
· We want to get a blue background so move both the Red & Green sliders to the far left.
· If you notice the RGB value is (HEX: #0000FF or Decimal: 0,0,25) )depending which is 

chosen. 
· Click on the Decimal or Hex button ( to the right of RGB Code label) to see equivalent 

values.
· You have just changed the background to blue.

Using the fine color control method,
· Move your mouse to the small color circle graphic, just above the Help button.
· A color pick box will appear.
· From this window you can either,    Pick a basic color or Create a custom color.
· Choose a blue color, Red = 0,    Green = 0 Blue = 255.    You can verify this by looking 

for the RGB values found just above the “Add to custom color button”.

3    Select the Text or Link & modify the Text/Link colors.
Place your mouse on the text. 

· For our first go, place your mouse on the “Document Text”.

Change the color of the text
· Move the all 3 RGB sliders to the far right.
· The result should be the color white.
· If you notice the RGB value is (HEX: #FFFFFF or Decimal: 255,255,255) depending 

which is chosen.

Repeat this process for the other text values ( in bold ) with the data below,
TEXT Hex Decimal Color

Document Text #FFFFFF 255,255,255 White

Standard Link #FFFF00 255,255,000 Yellow

Visited Link #FF0000 255,000,000 Red

Active Link #00FF00 000,255,000 Green

4    Check if text/colors or OK by Playing    with the various buttons & sliders .
Once you have set up the colors for the text, background & link text the real power of the 
Background Reality Checker is evident.    You can check to see if the,

· Background color contrasts enough with the text.
· Text is legible with background color.
· Enough contrast between the different text/link text.

If any of these are not to your satisfaction you can change the variables directly and see the 
result immediately. 

5    Load a background graphic
To select a background tile or graphic,

· Go to the “Background Graphic” text box



· For a new graphic select the “file” icon found to the far right.
· For a previously used graphic, select the “down” icon.    You can choose from any 

previously opened files.
You can now apply the same visual checks you used above with the graphic. 

6    Press OK and following code inserted into your document!
<<BODY BGCOLOR="#0000FF" TEXT="#FFFFFF" LINK="#FFFF00" VLINK="#FF0000" ALINK="#00FFFF">



Creating an HTML document

Tell me about how I can create an HTML document
This tutorial will take you through creating your first HTML document. We'll create a very simple personal 
home page.

Where are the tools I need?
HotDog for one.    But you don’t actually need HotDog.    You could just as well use a simple text editor 
such as notepad.      But there is a good reason to use HotDog.    HotDog is far superior to a plain text 
editor because of the range and quality of tools and the attention to detail in making those tools.      You 
also have to remember that while HTML is the “glue” of the Web there are many other tools that can be 
used as well as HotDog.    HotDog does not restrict you in using any third party tools.    In fact we 
encourage their use.      So you can choose to use any of your third party tools (Java, ActiveX, etc) to 
spice up your page.

What can I use an HTML Document for?
When the Web started way back in the early 1990’s HTML Documents tended to be restricted to 
education, research and the presentation of information.    Since then HTML document use has 
exploded.    New types of Web pages are being created everyday for an infinite number of uses. 
From entertainment to education from personal home pages to job vacancy pages, large 
corporations to students. 

Give me an example
1. Start HotDog. You will see the default editing template, which looks like this:

<HTML>
<HEAD>
<TITLE> type_Document_Title_here </TITLE>
</HEAD>
<BODY>

</BODY>
</HTML>

2. The first step we recommend is saving your work. This will put the file name on the documents 
bar at the end of the screen, and make it easier for HotDog's autosave feature to recover files.

To save your file, choose File Save.

Enter a name for the file.

3    All HTML documents must have a title. You can type this directly into your document, where it 
says  type_Document_Title_here, or you can specify it from the Format Document 
screen. 



To give your document a title, choose Format Document.

Enter the title in the box provided. The document title will appear in the caption bar of most 
browsers when your document is viewed; it will not otherwise be visible to users.

You can enter any text you like for the document title.

4    The content of your document must come after the <BODY> tag. Everything before the 
<BODY> is information that describes your document to Web Browser and Server software.

To enter information in your document that is visible to the user, position the cursor between 
the <BODY> opening tag and the </BODY> closing tag.

5    It often pays to give your document a heading that will be visible to the user. In most cases, 
this will be the same as or similar to the document title.

To create a heading for your document, just type the text you want for the heading. Then    
highlight the text you just typed in and 

· Go to Tags Headings
· Select the Heading1 
· Double click
· The selected text will now have the <H1> the text you typed in</H1>

H1 is the largest size heading, which you would normally use at the start of a document. H6 
is very small. Click the H1 button.

6  We'll divide our document into two sections: Who Am I?, and Hobbies and Interests. Each of 
these sections will need its own heading. Let's do Who Am I first.

Type the text: Who Am I? into your document. As with step 5, highlight the text. This time, 
instead of using the H1 button, we'll use the next size down. Click the H2 button

7    Now we need to enter some information into the document. A paragraph about who you are 
and what you do is probably enough.

To create a Paragraph, 
· click the Toolbars Tags. 
· You should notice the floating toolbar appear on the screen.
· Click on the button that has the <P> tag.
· This will insert a <P> tag.

Next type the paragraph. It will probably make things clearer for you if you get in the habit 
of putting a </P> closing tag at the end of each paragraph, but this is not currently required.

8  At this stage, you should have a document containing two headings, and a paragraph of text. 
Now is probably a good time to take a look at how this will actually be displayed on the World 
Wide Web.

To preview your work, click the Preview button on



· The Tools    RealTimeOutputViewer
· Or choose File PreviewDocument.

If this is the first time you've used HotDog, you will need to tell it where to find your browser. 
If you don't have a browser, you will need to download one from our Web site.

Select the browser from the file dialog, then click OK. HotDog will start your browser and 
display a copy of your document. Notice the difference in size between the H1 and H2 text.

To return to your document, just minimize your browser. HotDog will interact with it, so you 
don't have to start a new copy of your browser every time.

9    Follow steps 6-8 again to create another paragraph for your Hobbies and Interests.

10    By now, you should have a document containing two paragraphs of text, each with its own 
heading. Let's provide a visual clue to the user to separate these two paragraphs further.

Position the cursor before the <H2> tag that starts the heading for the second paragraph.

Choose Horizontal Line from,
The menubar    Insert HorizontalLine

This will insert an <HR> tag at the cursor position.    Preview your document again. There 
should be a recessed horizontal line dividing the two paragraphs.

11    Save your work again. You have created a basic HTML document!



Any more questions???

Questions, questions more questions.      Here’s the latest information for HotDog, Web and HTML 
related topics.

HTML
HotDog resources on the Web
Programmers Tool Tips



What's New in HotDog

And they say “you can’t teach an old dog new tricks…?”      In HotDog32    there are several 
major revisions in both functionality and looks.    The area you will notice the biggest change is 
stability.      Make sure you read on.    To top off greater stability,    there’s a cleaner interface,    a dash 
of new functionality and some spit and polish on the old.… who said you can’t teach an    Ol’ Dog new 
tricks?

Major Advances
Second generation ROVER
Toolbars
Sound Mixing Desk
Multi-File find & replace
Greater Stability

Enhancements
Repeat Last Command
Select Browser Option
Projects Option
FTP Upload
List Dialog Box
Table Dialog Box

New
Toolbone / Bonebar
Floating Toolbars
Customization



Frequently Asked Questions

Q How can I use Netscape without connecting to the Internet?
If you use an operating system without a built-in TCP/IP stack (such as Windows 3.1), you 
probably need a separate TCP/IP stack to connect to the Internet. Two common stacks are 
Trumpet Winsock and Chameleon from NetManage.

If you start the Netscape Navigator and you are not connected to the Internet, it will load your 
TCP/IP stack automatically. If you use a log-in script, then it will also start dialing your Internet 
Service Provider automatically.

This is obviously a problem when you need to preview a document from HotDog. HotDog will 
load Netscape , which will try and load your TCP/IP stack and connect you to the Internet. 
Even if you always log in manually, this setup can cause problems with HotDog.        Netscape 
have provided a solution to this problem: a file called MOZOCK.DLL.    The file ( mozock.zip ) 
is available from Sausage Software.

Q Why don't my images display properly?
There are a number of possible reasons,

· Using absolute instead of relative file references.
· Image not in correct image file format (ie GIF, JPG). 

Q How do I get my documents into the World Wide Web? 
Once you've created your web pages with HotDog, you need to put them on the Internet so 
they become part of the World Wide Web.      In most cases, this involves connecting to your 
ISP and transferring the files to a particular directory on their computer via FTP. The people 
who want to access your web pages will then read them from your ISP's machine.

The procedures for doing this vary for each ISP. You will need to contact them to find out how 
to display web pages using their system.

Q Why does HotDog only read the start ( or part of) my document? 
The Standard version of HotDog cannot open files larger than 32k. The Professional version 
handles files of any size.    If you are using HotDog standard and your file size is greater than 
32k this is most likely the problem.      Please note that large documents will take a long time to 
display over the Web, particularly for overseas users. 

Q How Do I Add A Counter To My Web Page? 
Many people use a counter to indicate the number of times their Web page has been visited. 
Unfortunately, there's nothing built into HTML that makes it easy for you to do this.          The 
only way we know of to add a counter to your home page is to use a CGI script.      CGI is a 
complicated topic, and you will need to learn a programming language such as “c or pearl” to 
use it.      For more information on CGI programming, please see the UseNet newsgroup 



comp.infosystems.www.authoring.cgi

Q Where is the “HotDog.ini” file located (So you can edit it) ? 
In case you go looking for this file, try looking in the local directory where HotDog32 is located. 
You should find the HotDog.ini here.    The reason it is not found in the ..\SYSTEM directory is 
that it’s getting a little crowded there.    This should make it easier to find.

Q How do I identify which floating toolbars I’m using?
Problem
If you create more than one floating toolbar, then you may ask “which toolbar is which?”    
There is no provision to see the name you give them when they are displayed on the screen. 
Solution
When you create them you can name the toolbar.    If you look on the menubar, then Toolbars 
you can turn each toolbar on/off as you wish.    This is the best way to tell which is which.

Q How do I make the floating toolbars disappear?
Turn Off
You can turn off the toolbars two ways,

· Go to the menubar Toolbars
and turn off the floating toolbar (Click on name to remove the tick.)

· Click on the small Windows system button (X, top right hand corner) on the floating 
toolbar.

Turn On
· Go to the menubar Toolbars
· Select the name of the toolbar you want to turn on.
· The floating toolbar name will appear ticked and appear on the screen.

Q What’s a sound pack?
What are they?
“Funky sounds & licks for your mouse clicks…”      A sound-pack is a collection of sound files in 
.WAV file format.    They are free and will include a Dog pack & funky rap pack (comming 
soon).

What are they for?
So you can have sounds playing through your soundcard when you do something with your 
programs.    This can be either using a function ( like opening a file ) or an event ( exit 
HotDog32).

How do I use them?
The sound packs are designed for use with the sound mixing desk.    You don’t have to use 
these sound packs.    You can use any old sound file as long as it’s in the .WAV file format.      
The sound packs are located in the sound directory in the same directory you have installed 
HotDog32.      If you want to create your own sound pack then you can,

· Add the sound pressing the Add sound button.
· Search & select the sound file you want    using the search window (dialog box).
· Make sure it’s in .WAV file format!
· The selected file should appear in the combo box above the add sound button.
· Then highlight with your mouse on the selected sound file in the combo box.



· Click with your mouse on the HotDog32 function 
· It’s found in large left hand combo box.
· Select the save button
· Then close button.
· That’s it.

Q What if I don’t have a browser…Do I need one?…Try ROVER!
ROVER is a mini-browser.    If you don’t have a browser you can fire up ROVER & use it as a 
browser.      It doesn’t have all the bells & whistles of stand-alone browsers but the ol’ dog has a 
few tricks other browsers don’t have like a multi-resolution button.    This allows you to see 
what a Web page looks like in other screen sizes.    ROVER also allows you to see a Web 
page straight off the Web, view it’s source then import this source straight into HotDog32 to 
look at.      If you still want to use your favourite . browser    by all means do so but don’t forget 
about the HTML editors best friend!

Q Why can’t I get HOTDOG32 to work using 16Bit operating system?
HotDog32 is written for Windows 95 & Windows NT operating system.    This alone makes it 
unusable for 16 bit systems.    There are good reasons why you cannot run HotDog32 in a 16 
bit operating system ( e.g. Windows 3.X),

· The programming language used to write this program uses 32 bit components.

Q Why is my machine running so slow?
If you machine is running like a slug on valium,    check to see how many applications you are 
running at once and your system suitability.

Q What’s the minimum system configuration I can use?
The most important thing to remember is that you require a 32 bit operating system.    
Translated into English, this means that some older operating systems and browsers will not 
work with HotDog.    Be aware that a  bare minimum set-up for hardware and software exists

Q How do I contact Sausage Software?
Contacting Sausage Software varies depending on what you want to contact us for!!!

Q What about Tech. Support?
Technical support for HotDog is available to registered users only.

Q. Where do I send Bug information?
The best thing to do is contact technical support and make sure you supply them with the 
relevant information

Q What’s the PGP key Sausage software uses?
The PGP encryption key is a secure method Sausage uses to encrypt sensitive data. If you 
don’t know how to use PGP or the, please check the file PGPKEY.TXT included. 

Q Why doesn’t my registration key work?
Tech. support has been getting a lot of questions about, keys that do not work.    It’s quite 
understandable.    Your in a hurry to install HotDog. The program is about to expire and self 
destruct. You have that life and death deadline to meet. That blasted key just will not work !!!!



Your key is probably not working for a number of reasons,
· You have not entered the key correctly
· You have not entered the matching text & key!
· Make sure you have entered 0 (zero) instead of O (letter Oh)

Q How do I use this Help effectively!
Navigation is achieved by,

· clicking on the buttons the <> arrows & the back option found on the menu bar.
Printing of any part of the help is possible,

If you can see a page you can print it.
· Select print from the top menu bar.
· You can’t print a pop-up this way!

If you want to print a pop-up,
· click your right hand mouse button.
· A small box will appear.
· Select print topic.
· That’s it. Your topic is printed!

Mistakes

· If you find any mistakes please send them to tech. support and explain the problem



Why doesn't my registration key work?

Tech. support has been getting a lot of questions about, keys that do not work.    It’s quite 
understandable.    Your in a hurry to install HotDog. The program is about to expire and self 
destruct. You have that life and death deadline to meet. That blasted key just will not work !!!!

Stay calm, everything’s okay.    Take a deep breath a repeat after me,

I shall check to see if I have entered the key exactly. 
If you don’t enter the key exactly as listed it will not work. 
Check to see if you have entered correct alphabetical case.

· The key is case sensitive.
· Check to see if the user name is spelt exactly as given.
· Remove punctuation from user name! 

I shall check to see    I’m entering the correct key for the correct version of HotDog. 
If you have purchased HotDog Pro ask yourself , “why am I entering the key
into the standard version?”      The opposite applies for those who purchase HotDog Standard.

I shall    check the given instructions again. 
Do you know    all the instructions, by heart?      Would you stake your life on it ?

Only if you can truthfully answer all of the above as yes , should you e-mail  Tech. Support. Of 
course for those of you in real trouble, get on the batline and send us your woes.    Once again 
here’s Tech. supports    email address. 



How do I use the Netscape Browser off line

Netscape have provided a solution to this problem: 
The file is called MOZOCK.DLL and is available as a zip file “mozock.zip” from the Sausage 
Software     Web site  .    Mozock "tricks" Netscape into thinking it is on the Internet. Here's how you 
use it:
1  Copy the file \WINDOWS\SYSTEM\WINSOCK.DLL to the same directory as your TCP/IP files 
(e.g. \TRUMPWSK). When you do load your TCP/IP stack, it will use this file.

2  Copy the file MOZOCK.DLL as \WINDOWS\SYSTEM\WINSOCK.DLL. When Netscape is 
started, it will load this file.

Please contact Netscape if you need more information on this.      We believe that using 
Microsoft's Wolverine TCP/IP stack for Windows for Workgroups (instead of your current stack) 
will also fix this problem. Contact Microsoft for information on Wolverine.      This problem should 
not occur in Windows NT or Windows 95 (which have TCP/IP networking built in).



Why is my system running like a slug on valium?
Win95 and Windows in general,    has a bad habit of gobbling up any spare resources such as 
memory for every Window program running.    This will be a problem for those who have minimum 
memory of say between 8 and possibly 12 Meg.    The more memory you have and the less 
applications you have running,    the better.



What's the bare minimum system?

The bare minimum set-up recommended to run FLASH is
· Computer Chip: IBM compatible Intel 486 DX 33
· RAM: At least 8 Mb or run like a slug on valium
· Operating system: Win95, Windows NT 3.51 & Windows Server NT 3.51 
· Browser software Browser comparable to Netscape V2.0 browser .



What other operating system can I use?

If you manage to run FLASH in another environment (e.g. SoftWindows, NT on an Alpha) please 
let us know. 

· Windows NT 3.5 - Intel
· Windows NT Server 3.51 - Intel
· Windows 95



I want to make a general query!
If you want to Download software,    check out the Sausage Software 
World Wide Web site.    If you want to make a general inquiry to 
Sausage then e-mail    the Sales Support crew,

e-mail: sales@sausage.com.au

Remember folks,
· E-mail only please.



I want to make a Tech Support Query!
The e-mail address for the Tech. Support crew is, 

support@sausage.com.au 

Remember folks, 
· make sure you supply the following information for tech. support queries
· Tech. support is unlimited for registered users only!



I want to report a possible bug!
The e-mail address for bugs is, 

support@sausage.com.au 

Remember folks, 
· make sure you supply the following information for bug reports!



I have some great technical suggestions!
The e-mail address for any technical suggestions is,

support@sausage.com.au 

Remember folks, 
· make sure you supply the following information for tech. suggestions!



Technical suggestion information!
To help out technical support staff please have the following information ready,

· Name (full name of person, company s/w is registered to)
· Registration name (full name of person, company s/w is registered to)
· Which software (which version what’s the name!)
· System configuration (operating system, browser & hardware)
· E-mail address (Please make sure it is legible)
· NB Other software (what other software was running at the time)
· Suggestions (List any suggestions you think necessary.)



What's the PGP key?
Following is the Key to be used.

User ID:    Sausage Software <sales@sausage.com>

-----BEGIN PGP PUBLIC KEY BLOCK-----
Version: 2.6.2i

mQCNAy/onO4AAAEEAObB1hUpJyQfkx/GUdSyiPdnoAhzK6WkI0fSiNbPat0Onxka
s7EsdvypkiN6IvIm/HSNh8SMj6J+0EsYg6WC3iL8HlQmW+Uo2QrjDccJJhFLwNBS
nnj4utgh/+etZ7M6/dZMWLgLTxpqbJJI/7e84izGpjwqC38kzeKJL6+Z6+vVAAUR
tCRTYXVzYWdlIFNvZnR3YXJlIDxzYWxlc0BzYXVzYWdlLmNvbT4=
=DX8C

-----END PGP PUBLIC KEY BLOCK-----



Technical support information!
To help out technical support staff please have the following information ready,

· Name (full name of person, company s/w is registered to)
· Registration name (full name of person, company s/w is registered to)
· Which software (which version what’s the name!)
· System configuration (operating system, browser & hardware)
· Send a COPY of any HTML you are using
· E-mail address (Please make sure it is legible)
· If an error happens (write down exactly what happened or better print it!)
· NB Other software (what other software was running at the time)



Bug Report Information!
To help out technical support staff please have the following information ready,

· Name (full name of person, company s/w is registered to)
· Registration name (full name of person, company s/w is registered to)
· Which software (which version what’s the name!)
· System configuration (operating system, browser & hardware)
· Send a COPY of any HTML you are using
· E-mail address (Please make sure it is legible)
· If an error happens (write down exactly what happened or better print it!)
· NB Other software (what other software was running at the time)



Browser
HTML
JAVA
Browser
ISP
Web document, Web page, Home page



The Jargon Buster

ASCII
American Standard Code for Information Interchange or ASCII is an internationally agreed 
standard by ANSI for the exchange of keyboard and some non-keyboard characters.  Eg:    ASCII 
allows for the free exchange of text data between computers

Browser
An application program that can browse the World Wide Web and view HTML document, more 
commonly called a Web page. A Browser can come in many forms.    The type of browser we are 
most interested in has the ability to show text, images and sound. 

Bonebar:
The bonebar contains all the commonly required functions you may need to interact with the 
system outside HotDog32.    It’s a cold world out there so know where to find that bone when you 
need to use Preview, New, Open, Save, Upload, Rover, Toolbar & Help!

Configurable toolbar:
A configurable toolbar means you can choose what functions or actions you want to be 
associated with a menu.    The customisable toolbar(s) is an example of this.    It allow you to 
choose what function is associated with what button.    An example of a non-customisable toolbar 
is the bonebar and the menubar.

Floating toolbar:
Essentially it’s the same as any other toolbar but it can be manipulated like a window. i.e.: it can 
be moved or minimised.    HotDog32 floating toolbars also have the distinction of being 
alterable. ie:    You can add/delete functions to your toolbar.

HTML
Hypertext Mark Up Language is a text mark-up language that concerned with the description of 
the contents of a document.    An HTML document can generally be recognised by two things, 
information which is stored in ASCII and the formatting commands or tags.    HTML should/does 
not describe the layout of a document however much the extensions to HTML indicate.

HTML document
An HTML document is often referred to as Web page, Web document or even Web doc.    For our 
purposes an HTML document describes something written, visually and/or aurally    recorded on a 
topic marked with HTML tags and possibly jazzed-up with some trimmings, to form a single 
cohesive document accessible to a browser on the World Wide Web 

An HTML document also be described as a file or collection of files that have been marked-up 
using HTML.    The only difference between an HTML document and a more traditional paper 
document is,



· An HTML document is in a digital format called ASCII
· An HTML document is marked up using HTML mark-up language, i.e.: tags.

HTML file
An HTML file is simply a Web page, HTML page, web document or HTML document that’s 
been saved.    For our purposes an HTML file is a Web page et.al.,    that’s been saved.

ISP   (  I  nternet   S  ervice   P  rovider)  
An ISP provides a connection for third parties (such as yourself) to connect to the Internet.    An 
ISP exists because it’s very expensive, time consuming and difficult to keep up with the 
technology of providing services such as e-mail, Web page design, Internet access etc.    Your    
local ISP is your connection to the Internet.    Unless you have access to your own Internet server. 
(Lucky you!)

PGP
PGP encryption is a secure method Sausage uses to encrypt sensitive data. If you don’t know 
how to use PGP or the key, please check the file PGPKEY.TXT included. 

System commands:
Are include all those functions you commonly do with Web documents such as viewing, saving 
calling Help etc.

Toolbar:
Toolbar(s) are a list of functions found on the screen you can access to    interact with HotDog32 
to do something. For instance, HotDog32 has three different toolbars,    the menubar, the 
bonebar and the customisable button bars.      For example from the menubar you can get Help 
or access a file. 

URL
A URL is an abbreviation for Uniform Resource Locator.    A URL is a unique address that    
“points” to a resource on the Internet. 

Eg:    If you want to find the latest software at Sausage Software check out the URL.      The URL 
contains a lot of information on the technical aspects of locating a resource.

User interface:
This is the human side of the program that allows you to interact with the bit’s and bytes beneath 
the hood of your computer.      In HotDog32, the interface is audio- visual.    On the visual side we 
have the toolbars, menubar, bonebar & customisable floating toolbars: What a mouthful!.    On the 
audio side we have sounds that can be assigned to functions.

Web page & Web document
An Web page or document is also often referred to as an HTML document or even Web doc.    For 
our purposes a Web document describes something written, visually and/or aurally    recorded on 
a topic marked with HTML tags and possibly jazzed-up with some trimmings, to form a single 
cohesive document accessible to a browser on the World Wide Web 

An Web document can also be described as a file or collection of files that have been marked-up 
using HTML.    The only difference between an Web document and a more traditional paper 
document is,



· An Web document is in a digital format called ASCII
· An Web document is marked up using HTML mark-up language, i.e.: tags.

Wildcards
Wildcards are for finding files or groups of files using a “*” (star) to represent an unknown.    Back 
in the good old days of DOS command line operating systems you could find a file or series of 
files by inserting a wildcard.    With this feature you could enter incomplete information and search 
for an unknown file.    For example if you know what the extension of a filename is but forgot the 
exact name.    You can search for all files with the extension of .htm, by typing *.htm at the 
command line prompt.





//      AREA:    “What’s this pop-ups”

//      SORT:      Alphabetical

//      Additions:
// 240596 Menu item, File menu
// 240596 Menu item, Edit menu
// 240596 HotDog Overview
// 270596 Menu item, View menu
// 280596 Web, publish pop-ups
// 060596 Format stuff, URL
// 111206 Insert
// 170696 Insert Marquee
// 180696 Insert Lists



HotDog files when using Standard & Pro

Files greater than 2 Meg.        Warning!!!
HotDog Standard can't handle files bigger than 32k. If you need to edit large files, you should upgrade to 
HotDog Professional.

Some functions may not work correctly in files larger than 2 Megabytes. The results maybe unpredictable. 
Suggestion:    Break big files into more numerous and but smaller files.



How do I add a file to the Project Manager?

1  Go to the Project Manager window & then the Files folder.
· Move your mouse cursor to the File option on the title / menu-bar. 
· It's found on the top line of HotDog’s main window. 
· Click once. You should see the options appear. 
· Move down the options and select Project Manager. 
· Click on it. The Project Manager window will now be visible.
· Select the File folder.

2    Add a file
· Press Add. The Open File window will appear.
· Click on the File to be added to the Project & press OK



How do I change the Big First Letter?

If you want to change the Big First Letter you have to,
· Highlight your Big First Letter

Highlight text in your document before using this options.    The appropriate tags will be 
inserted at the start and end of the text, so that only the selected text is formatted.

· Find where the option is
Go to the Option General Tab

· Change the default size of the first letter
Look for the “Big First Letter” option near the bottom of the Dialog box
The default relative font size.value is +2
Click the down arrow 
Select a new relative font size

· You could also go into the raw HTML code and alter the default relative size font value.



How do I Color the Tags Now?

This option allows you to override the color tags after x seconds . option.    As the caption 
describes, you can color your tags quickly.      To get there,

· Move your mouse cursor to the Edit option on the title / menu-bar.
· It's found on the top line of HotDog’s menu bar in the main window. Click once.
· Move down and select the Color Tags Now option. 
· Click on it.



How do I decipher the location description?

There are multiple entry points for any given tool in HotDog, toolbars, shortcut keys etc.    But one 
sure way of finding a particular tool is to use the menubar.    The location description gives you,

· The menu from which to choose a tool in the menubar. 
· Then the option in that menu found in the pull-down list.

For example,
· MENU        Option

Tags              Document
Help                HTMLReference



How do I drag something?

In HotDog, items from the Tags List, Character Codes List, and File Manager can be dragged 
and dropped into your documents. 

To drag something, 
· click on it with the left mouse button.
· Keep the button pressed down. 
· If the item you clicked on can be dragged, a picture will appear when you move the mouse. 

Move this picture to another object and let go of the mouse button.
· This is called "dropping". 



How do I find the Color Tags Now option?

· Move your mouse cursor to the Tools option on the title / menu-bar.
· It's found on the top line of HotDog’s main window. Click once.
· Move down and select the options folder.    Click on it. 
· Select    the Colors folder.
· We are most interested in Tag Type & Tag Type Color.



How do I Format the font color?

Select the Format FormatFontmenu option.    You will notice a colored box will appear 
underneath.    If you want to change text color, 

· click on the colored box
· A default color dialog box will appear.
· In this box you can select a particular color
· Press OK
· Notice the text color has changed.



How do I format the font size?

If you want to change a Relative font size, select the Format FormatFont menu option,
· Select the text you want to change by highlighting it with your mouse.
· Select the relative font size
· That’s it.



How do I open the Project Manager?

· Move your mouse cursor to the File option on the title / menu-bar. 
· It's found on the top line of HotDog’s main window.
· Click once. You should see the options appear.
· Move down the options and select Project Manager.

· Click on it. The Project Manager window will now be visible.



How do I open a Project?

· Move your mouse cursor to the Tools option on the title / menu-bar.
· It's found on the top line of HotDog’s main window.
· Click once. You should see the options appear.
· Move down the options and select Open Project.
· Click on it. The Project window will be visible.



How do I Report on a Project?

· Move your mouse cursor to the File option on the title / menu-bar. 
· It's found on the top line of HotDog’s main window.
· Click once. You should see the options appear.
· Move down the options and select Project Manager.
· Click on it. The Project Manager window will be visible.
· You should see, “ Details Files Links”.      Select the File folder.
· Select and press the Project Report button.

· This writes the report to a .RPT file and gives you the option to view it.



How do I search for a tag in Tag menu?

HotDog will search the tag description and/or the beginning marker.    If you want to search for a tag,
· Type in what you want to search for.
· Partial searches are allowed, wildcards are not!
· If you do not find what you’re looking for then press, “Find Tag”
· To see what your search has found look for the,

Tag in the top text box
Tag description in the bottom text box.



What’s a Text Area?

This is a multi-line area of text, usually used to enter brief messages. You can specify the number of rows 
and columns in the Text Area.



What’s a Text Box?

This is a single-line area where the user can type text. For example, you would use this to let 
readers enter their name or e-mail address.



What’s a List, Bulleted?

This list type ( Bulleted ) has the following attributes,
List Heading
The list header. The list items will normally be indented.
Type
Applies to Bulleted and Numbered lists. Lets you change the appearance of the bullets or 
numbers, for example to use lower case Roman numerals (i,ii) instead of Arabic (1,2), or to use 
square bullets instead of round ones.



What’s a List, Definition?

This list type ( Definition )has the following attributes on dialog Window that you work with,
List Heading
The list header. The list items will normally be indented.



What’s a List, Plain?

This list type (Plain )has the following attributes on dialog Window that you work with,
List Heading
The list header. The list items will normally be indented.



What’s a List, Numbered?

This list type ( Numbered ) has the following attributes,
List Heading
The list header. The list items will normally be indented.
Type
Applies to Bulleted and Numbered lists. Lets you change the appearance of the bullets or 
numbers, for example to use lower case Roman numerals (i,ii) instead of Arabic (1,2), or to use 
square bullets instead of round ones.
Start from
Applies to Numbered lists only. Lets you start the automatic numbering from a specific number, 
instead of from 1.



What’s a Snaglet?

Program, application, applet, et-al.    You have probably heard all of these before.      What about a 
snaglet?.    For our purposes a Snaglet is a Sausage Software applet:    A single purpose program 
that does one job and one job well.      An example of a Sausage Software applet is FrameGang.    
FrameGang generates frame HTML code in the form of a frame document.      This Snaglet ( and 
others to come) have been refined and inserted into HotDog.      You can find Snaglets in HotDog 
from the menubar,      Tools Snaglets.



What about inserting a Web page?

If you see a great Web page and wondered, “How did they do that?”.    If you can see the source HTML 
you can get a pretty good idea of how a to duplicate an effect.    Try the following using ROVER,
Go to a Web site:
Type in a URL into the Location.    Hit enter
View the source HTML:
Press the View Source button
Insert:
Press the Open in HotDog button



What about viewing a Web page?

If you want to surf your favourite Web site in ROVER try the following,
Go to a Web site:
Type in a URL into the Location ( Item box ).    Hit enter

View previous Web sites used:
Notice to the right of the Location is a down arrow icon.    Pressing    the icon will bring up list of 
previously entered Web URL’s.



What's an absolute reference?

Absolute References are used if the file or graphic is not in the same directory as (or a subdirectory of) 
the current document. For example, if you have a document called C:\HTML\INDEX.HTM, and you insert 
the image C:\GRAPHICS\PICTURE.GIF, HotDog will insert the image like this:
<IMG SRC="file:///c|/graphics/picture.gif">



What an example of a form use?

For example, you might use a form to let users subscribe to a mailing list. They would enter their name 
and e-mail address, then click a button to send the form to you. The form could be linked to a program 
which automatically adds their name to your mailing list.



What’s an example of lists

Given a specific example “Frogs, Flies, Bees”    the following is possible.
Ordered (or Numbered) List:

1. Frogs

2. Flies

3. Bees

Unordered (or Bulleted) List:
· Frogs

· Flies

· Bees

Plain List:      The Plain list is actually an Unordered list with no bullets.
Frogs

Flies

Bees

Definition List:
Frogs: green things that go "ribbit"

Flies: black things that go "bzzzzz"

Bees: black and yellow things that go "bzzzzz"



What are the different screen resolutions?

The Width checker allows you to view Web documents in different screen resolutions.    Use the Original 
option to restore ROVER to it’s previous size.    You can use following screen size options,

· 640x480 (Width x Height),
· 800x768 (Width x Height),
· 1024x800 (Width x Height),



What are the Microsoft Color Names?

Black ,    Olive,      Teal,      Red,      Blue,      Maroon,      Navy,      Gray,      Lime,      Fuchsia
White,      Green,      Purple,      Silver,      Yellow    &    Aqua.



What are the Net aware features?

ROVER is now able to work as a mini browser.    It’s not as functional as a fully featured browser, 
but you can,

· Enter a URL into the status bar & surf.
· Navigate on the Web using left & right hand arrows and the stop button.
· View either Web page or it’s HTML source code
· Insert current Web page source directly into HotDog.
· View the next    URL ROVER is going to use by looking at ROVER’s titlebar.



What’s CGI?

CGI stands for the Common Gateway Interface. It is a way of letting HTML documents interact 
with programs.

CGI programs can be written in almost any programming language, but the most commonly used 
ones on the Internet are Perl and C. This means that to use CGI, you will need to learn a 
programming language. We recommend taking a course if you're serious about using it.



What choices do I have with Bullet Appearance?

Notice the bolded HTML this is recent    Netscape addition.    You can modify the type attribute in 
the dialog or manually edit it in HotDog.    You can choose from either circle, disk, or square.

<UL TYPE=circle>

<LI>

<LI>Frogs

<LI>Flies

<LI>Bees

</UL>



What's Sausage Software's WWW address!

US: http://www.sausage.com
Europe http://www.fourthnet.co.uk/hotdog/index.html
Australia: http://www.sausage.com.au



What do you mean by default settings?

When you first start up the program it comes with some default settings.    These settings are there as a 
guide to what is possible.      Take for example the Toolbars.    The default toolbars are, Common 
Commands, Tags and Your Text.      You don’t have to keep these toolbars.    There are no restrictions on 
what combinations of tools you choose!

Don’t be fooled into thinking that’s all you can do.
HotDog allows you customize a lot of the program to suit your needs.    Your in charge.    If you want to 
check what’s customizable use the index and type-in “customize” as a keyword to search.



What is the Behavior?

Determines how the text will move within the marquee.    There are 3 attributes, 
SCROLL - the text will move in from one side, and disappear off the other
SLIDE - the text will move in from one side, then stop when it touches the other
ALTERNATE - the text will bounce back and forth within the marquee



What’s Marquee Message?

Enter your message text here.    There is a limit on the amount of text you can put in ( Around 64K for text 
file. )      This means you can type in 64,000 characters which is huge message. Better to keep it short and 
sweet. 



What’s the Check Box?

This provides a square box for the user to click. If they select the corresponding option by clicking on the 
Check box, the box will appear with a X in it.

The difference between a radio button and a check box is that when the radio button is clicked, all the 
other radio buttons in its group will be cleared. You can click several check boxes in a group without 
affecting any of the others.



What’s the Hidden Box?

This provides a Text Box that can't be seen by the user. You might use this to store specific data about the 
form which you want to pass to your CGI program but don't want the user to see.



What’s the Horiz. & Vert. Space

The distance between the top and bottom margins of the marquee, and the surrounding text (in pixels).      
Microsofts new tags feature names for commonly used colors, so you don’t have to use hexadecimal 
RGB triplets (e.g. FFDDDD).



What’s the Image?

Lets you define an Image the user can click on. This image will have the same effect as the “Submit 
Button”, except that the X and Y co-ordinates of the mouse pointer when the image was clicked will also 
be passed to the   CGI   program.



What’s the Marquee Height & Marquee Width

The height & width of the Marquee, or as a percentage of screen height



What’s the Number of Times To Repeat Loop?

Specifies how many times text will scroll across the marquee.      If LOOP=INFINITE or LOOP=-1, the text 
will repeat indefinitely.



What’s the Text to HTML dialog look like?

The dialog is divided into 4 areas.    Do not adjust your Monitors.    This image is “fuzzy” on purpose.    
Have a look at the way the dialog is divided into 4 distinct areas.



What’s the Time between Messages ?

Specifies the number of milliseconds between each successive draw of the marquee text.



What’s the Scroll Direction?

The direction that the text should scroll towards. It can be either LEFT or RIGHT



What’s the Submit Button?

When this button is clicked, the data in the form will be send to the URL specified in the Form Details 
screen. 



What’s the Space between Messages?

Specifies the number of pixels between each successive draw of the marquee text.



What’s the Password Box?

This provides a “Text Box” that will display a special character like * each time the user presses a key. 
This lets them enter passwords, but prevents anyone looking at their screen from seeing what the 
password is.



What’s the Radio Button?

This provides a "radio" or "option" button for the user to choose from a list of options.

The difference between a radio button and a check box is that when the radio button is clicked, all the 
other radio buttons in its group will be cleared. You can click several check boxes in a group without 
affecting any of the others.



What’s the List Box?

This lets you create a list for the user to select items from. By default this list will be a combo box (also 
known as a pull-down menu), where the list will drop down when the user clicks the arrow at the right of 
the box.      You can create lists that allow the user to select more than one item.



What’s the "Low Resolution Source File" option do?

Some browsers support an alternate, low-resolution file. The low resolution file is displayed initially, then 
the high-resolution file is gradually painted over the top of it. This means that users on slow connections 
can see the basic image quickly, or wait and see the full image. 



What’s the Reset Button?

When this button is clicked, all the choices the user has made and text they have entered will be cleared. 
The form will look exactly as it did when the user first entered the page.



What's the "Source File option" do?

The image file. This will usually be in GIF format, but newer browsers also support the JPG 
format. The image file can be in the same directory as 

the current document, 
Eg    apicture.gif

in a relative directory 
Eg    pictures/apicture.gif

or any valid Internet address 
Eg    HTTP://WWW.ASITE.COM/PUB/GRAPHICS/apicture.gif).



What's the Alternative Text Description do?

This is the description of the hypertext link.    You can use this option to give a description of the Image 
you have selected.    Remember not everyone has the latest version browsers.    There are a lot of users 
on the back end of 2400 baud line connected to a UNIX shell account using text only browsers like LYNX!



What’s the "Alignment" option do?

Sets the way the image is aligned against text on the same line.



What’s the "Alternate Description" option do?

Text-only browsers will not be able to see your graphics. This field lets you provide a brief description of 
the picture for these people, so its meaning is not lost.



What’s "Beginning Markup"

This is the HTML text that will be inserted before the cursor and/or any selected text. This does not have 
to be HTML code - it can contain any text you like.



What's a clipboard?

The Clipboard lets you store text in the computer's memory, and retrieve it into different documents, and 
different programs. It works in much the same way as the "memory" button on a calculator. The standard 
Windows clipboard only remembers the last thing it contained; other versions of Windows have more 
sophisticated Clipboard tools.



What's a default browser?

The default browser is the browser you load & use most of the time.    In this version of HotDog 
you can use more than 1 browser. 



What are the descriptions for?

The following list consists of tag descriptions associated with an HTML tag, found in the tag menu you 
have selected.    They are listed for the sake of documentation completeness.    In the next version of Help 
these descriptions will have their associated HTML Tags listed in more detail.



What are the pre-defined date/time formats?

If Thursday the 13th of June 1996, at 2.56PM in the afternoon as an example, you can choose 
from,

· Thursday, 13 June 1996
· Jun, 1996
· Jun, 96
· Jun - 96
· 14:56
· 14:56:43
· 2:56PM
· 2:56:56PM



What's a relative reference?

Relative References are used when the file or graphic is in the same directory as (or a subdirectory of) 
the current document. For example, if you have a document called C:\HTML\INDEX.HTM, and you insert 
the image C:\HTML\PICTURE.GIF, HotDog will insert the image like this:
<IMG SRC="picture.gif">



What's the Document to Launch do?

If you want to use the image as a hypertext link, specify the document to go to here. Note that images can 
launch CGI scripts, files to download, or other internet items.



What’s the "Horizontal Distance From Text" option do?

Lets you specify the horizontal (left-right) and vertical (up-down) space between the image and any text 
that flows around it. This prevents text from appearing right against the image.



What's the Image File option do?

Allows you to select & insert images.    The images will usually be in GIF format, but newer browsers also 
support the JPG format. The image file can be in the same directory as the current document (for 
example apicture.gif), in a relative directory (for example, pictures/apicture.gif), or any valid Internet 
address (such as HTTP://WWW.ASITE.COM/PUB/GRAPHICS/apicture.gif).



What’s an "Image Map"?

Specifies that the picture is a clickable image map. For example, you could create a picture of an office. 
Clicking on the bookshelf might take the user to a library; the computer screen might go to a computer-
related page or a telnet session; the telephone might provide information about contacting the authors.



What's the "Insert As" option do?

Specifies whether the picture will be created as an Image, figure or Image Maps.      If you are using an 
image map,    using either the Figure option or Image Map option depends on the type of image map.      If 
you are using a client side image map then use the Figure option.    If you are using a server side then 
use the Image Map option.



What's an ISP?

An ISP provides a connection for third parties (such as yourself) to connect to the Internet.    An 
ISP exists because it’s very expensive, time consuming and difficult to keep up with the 
technology of providing services such as e-mail, Web page design, Internet access etc.    Your    
local ISP is your connection to the Internet.    Unless you have access to your own Internet server. 
(Lucky you!)



What's a Project Report?

A Project Report is a snapshot of all the images and links contained in a project file. The report    
writes the summary to a .RPT file and gives you the option to view it.



What does Publish Document do?

The Publish Document function, formats the current document ready for uploading to the Internet. 
For example by selecting this option you can convert DOS to UNIX file names or place 
documents into separate directories.



What are the visual attributes that can be altered?

Bold formats the text in Bold type. Bold is not recommended; you should use Strong instead.

Emphasized provides some emphasis of the text and should be used instead to Italics. 

Strong provides strong emphasis to text and should be used instead of Bold. 

Underline      Underline is a proposed HTML3.0 tag.

Italics formats the text in Italics.    Use of Italics is not recommended; you should use Emphasized 
instead.

Small caps

Blinking      This is a Netscape HTML tag.    It makes the text blink on and off when it is displayed. 
Some people object very strongly to blinking text on (mainly) aesthetic grounds, although it can 
provide useful emphasis. 

Superscript formats the text as a superscript & is a proposed HTML3.0 tag.

Subscript formats the text as a subscript.& is a proposed HTML3.0 tag.

Big makes the text big & is a proposed HTML3.0 tag.

Small makes the text small & is a proposed HTML3.0 tag.



What are the necessary Project Details?

Directories: What directory you want to save the Project.
Files: What files you want to assign to the Project.
Project Name: Name you assign to the Project.
Drives: What drive you want to save the Project.
OK, Cancel & Help: Boring but essential.



What's a Project?

· A    Project is a file which can group together all your HTML Web files.
· Organizing your Web files into Projects allows flexible manipulation of many such files.
· Eg:        Assign, say 40 HTML files ( a whole Web document ) to a project.
· All 40 files can    then be opened or closed by simply opening or closing the corresponding 

project . 



What's relative font size?

Font sizes can be expressed either as a size relative to the base font size, or as an absolute size. 
Sizes range from 1 to 7; the default size is 3.      For example, normal text would be rendered in 
the base font size (3):

HotDog is a great program

If you formatted this text with FONT SIZE=+1, it would be rendered as the base font size + 1, or 
size 4:

HotDog is a great program.

If you use FONT SIZE=7 (an absolute number), the font would be formatted as Size 7.

HotDog is a great program.



What is HotDog?

HotDog is a stand-alone program. This means that it doesn't need an expensive word processing 
program to run. It also means that you can deal with your HTML documents directly, instead of 
having to "pretend" that they're standard word processor documents.



What is the Background color?

Specifies the background color for the marquee. Instead of using the hexadecimal RGB triplet (e.g. 
#FFFFFF), you can use a Color Name.      There is also the facility to customize your own colors with the 
color selection palette icon. ( The small 3 colored icon to the right of the text box. )



What’s in the Explanations?

If you want a more “in-depth” explanation of a particular topic related to HotDog, HTML or the 
Web in general.    Here’s the place to look.



What’s in Menus?

If you want to find a feature or tool in HotDog?      One way is to look down the backbone of    
HotDog to search for that particularly meaty option.      Each menubar item has a summary page of 
options.      Each Menubar option has the following base amount of information,

· Description
· Location of the option, eg:    View Toolbone
· Features that option is capable of.
· User tips for the particular option.



What’s a Tag Description

The description of the tag appears as a menu item in the Tags menu, and a list item in the Tags 
list. To change the description, click on it and type a new one.



What’s Hypertext Target?

Hypertext Targets let you jump to specific locations within documents. You can jump to a target in the 
same document, or another document. Targets are most often used in long documents which are divided 
into several sections.      The current HTML 3 draft defines targets with the ID token.    For example,

<P ID="contents"> 

will make a paragraph a target, with the name contents.      Previous versions of HTML used the 
NAME token in an Anchor. For example,

<A NAME="contents">

HotDog defaults to the first (HTML 3) method. If you prefer to use the older method, you can 
change the default target code from the General section of the Options screen.



What is Text Alignment?

Specifies the location of text around the marquee.    Can be either TOP, MIDDLE, or BOTTOM.



What’s in the Tutorials?

If you want a “How to” tutorial on a particular topic then check out the tutorials.      The tutorials listed 
below are specifically designed for HotDog32 and have been written with the following things in mind,

· Summary of the feature.
· Where is it located in HotDog.
· What’s it for.
· Give me an example.



What do you use HotDog for?

HotDog offers many ways to making creating HTML documents easier. If you are an experienced 
HTML author, you can type all the formatting tags directly, or select them from menus and pop-up 
lists. If you are new to HTML, HotDog has screens to let you insert images, formatting, and 
hypertext links into your document without having to learn the HTML language.



What's the file extension for Project files?

Project files have the extension of ".PRJ".    These files contain the file names of all the Web 
documents currently in the project.



What's UNIX?

UNIX is another operating system and a sort of big Uncle to DOS.    Popular with the Web 
movement and academia, UNIX is known for it’s terse syntax and unforgiving manuals.    UNIX is 
distributed for free along with access to it’s source code.



What's a URL?

A URL is an abbreviation for Uniform Resource Locator.    A URL is a unique address that    
“points” to a resource on the Internet. 

Eg:    If you want to find the latest software at Sausage Software check out the URL.      The URL 
contains a lot of information on the technical aspects of locating a resource.



What's a Window list?

This lists all the documents you currently have open. The information is the same as that provided on the 
Documents Bar, except the Documents Bar indicates whether the document has been saved or not, while 
the Window List shows the full path name of the document instead of just the file name.



What is WAIS?

Wide Area Information Server or WIAS for short,    is a search engine found on the Internet.      
Using WAIS it is possible to find information sources even if you don’t know where to look.    
Difficult to use and slowly being superseded, WIAS is still a good means to find information if you 
have the knowledge how to use it



What's a Web document?

A Web page or web document is also often referred to as an HTML document or even Web 
doc.    For our purposes a Web document describes something written, visually and/or aurally    
recorded on a topic marked with HTML tags and possibly jazzed-up with some trimmings, to form 
a single cohesive document accessible to a browser on the World Wide Web 

A Web document can also be described as a file or collection of files that have been marked-up 
using HTML.    The only difference between an Web document and a more traditional paper 
document is,

· An Web document is in a digital format called ASCII
· An Web document is marked up using HTML mark-up language, i.e.: tags.



What’s the Alignment option?

Lets you position the line against the left edge of the screen(Left), the right(Right), or in the 
middle(Center).



What’s the "Width, Height & Border" option do?

The Width and Height of the image. By default, this is specified in pixels. You can change this to en by 
typing UNITS="en" in the tag. Most browsers that support this tag will resize images to fit these attributes. 
Specifying width and height can speed image display (since the browser doesn't have to determine them 
itself).

The Border width Specifies the width of the border around the image. If Border Width is 0 the image will 
not have a border. This may make it difficult for the user to determine if the image is clickable or not.



What are the Color Tags Options?

These options allow you to change the speed at which the colored tags appear.
· Go to the Colored Tags option.
· Select the Editing folder.
· To change the time lag for the coloring of the tags.
· Select the top tick-box option.
· Click on box for tick.
· Select the second top tick-box option.
· Time in seconds.



What's the HotDog Icon look like?

The HotDog Icon can be found on the menubar to the far left of the menu items.    When a file is 
maximized it can be found on the menubar or at the top of the file window when a file is minimized.



What’s the No Shading option?

If you check this box, your line will display as a solid bar in Netscape.



What’s the Thickness option?

Sets the vertical size of the line.    You can choose the width to be from 1 to 10.    They are relative values 
and can be edited in HotDog.



What’s the "Vertical Distance" option do?



What’s the width option?

The horizontal width of the line. This can be either an absolute number in pixels, or a relative number 
expressed as a percentage. Relative widths are preferred to ensure compatibility with all screen sizes.



Where's an example to try out Color Tags Now?

To change options for Tag type & Tag type color 
Go to the Colored Tags option, should see the following,    you will not see the text in blue.

OPTION Eg:

Foreground Color White
Background Color Dark blue
Default Tag Color Yellow
Tag Type HTML3
Tag Type Color Red

For each of the above options in Red, change the options as suggested above. 
· Eg:      Foreground Color    White., etc.
· All options can be changed. (Example)
· Pay particular attention to Tag Type & Tag Type Color.
· Save by pressing OK.



Where's the print facilities?

OOOPS!!!      At the moment the print facilities have not been included.    We are working on this 
one.    Please be patient we are experiencing some minor technical difficulties.



What's the Project Manager?

· The Project Manager allows you change files ( add, delete ) in your Project. 
· Move your mouse cursor to the Tools option on the title / menu-bar. 
· It's found on the top line of HotDog’s main window. 
· Click once. You should see the options appear. 
· Move down the options and select Project Manager. 
· Click on it. The Project Manager window will be visible.
· For more information check out Project Manager Help.



Where do I find the "System monitor" program? 

You can find the System Monitor program if you go to the,
· Windows Start menu.
· Select the Accessories option.
· Select System Tools option.
· Select the System Monitor program.



Where's some sample code for Color Tags Now?

A good example to try.      Start a new file in HotDog.    You need to add the colored text only.      
After you have typed this in continue with the previous example. 

<! - - Sample for you to try Color different Tags.  - - > 
<HTML>
<HEAD>

<TITLE>type_Document_Title_here</TITLE>
</HEAD>
<BODY>

<CENTER>Test this line out</CENTER> <! - -    HTML 3.0 Tag    - ->
<BGSOUND SRC=MUSIC.WAV LOOP=5> <! - -    Microsoft Tag - -> 

</BODY>
</HTML>
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Detailed Explanations;

The following explanations have been written to illustrate to a novice user the certain features    
related to HotDog32, the Web and Internet in general.      You will notice that the examples are on 
specific as well broad topics.    As time goes on more explanations will be added,    highlighting 
specific areas that a user might like to know.

EXPLANATIONS:
Absolute and relative file references
Characters
Hypertext links
HTML Reference
The document bar
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HotDog Menus

Must update this it’s not accurate!

Menu Item Shortcuts
Name Ctrl Letter Alt Dialog Box
File menu Alt+F

New Ctrl+N N
Open Ctrl+O O Yes
Save Ctrl+S S
Save As Ctrl+A A Yes
Save All
Close C
Preview Document F10 e Yes
Publish Document Ctrl+U u Yes
Print
Print Preview
Print Setup
Open Project Ctrl+P r Yes
Close Project
Report On Project t
Exit Ctrl+Q x

Edit Menu Alt+E
Undo u
Cut t
Copy c
Paste P
Append A
Find Ctrl+F F Yes
Replace Ctrl+R R Yes
Tag Information Ctrl+Alt+T g Yes
Select All l
Color Tags Now Ctrl+4 o
Refresh Document s
Absolute to Relative b
Relative to Absolute v
Translate Extended Chars Ctrl+E n
Select This Tag h

View Menu Alt+V
Toolbone b
Tags T Yes
Special Characters C Yes
HotDog File Manager F Yes

Insert Menu Alt+I



Image I Yes
Image (Advanced) v Yes
Embedded Item E Yes
Marquee M
Form Element F Yes
Hypertext Targets H Yes
Table Ctrl+T T Yes
List Ctrl+L L Yes
Horizontal Line z Yes
Text File T Yes
Special S
Simple URL F4 m Yes
Jump to a Document in This System J Yes
Jump to a Document on Another System A Yes
Jump Within This Document W Yes
Launch an Internet Service u Yes

Tags Menu Alt+T
Document D
Body r
Content C
Headings H
Attributes A
Graphics G
Font F
Lists L
Forms r
Tables T
Miscellaneous M
Custom u

Toolbars Alt+o
16 Bit Elements
File and Edit
Text ‘n’ Stuff

Format Menu Alt+F
Font F Yes
Document D Yes
Bold B
Italics I
Underline U
Blinking l
Big First Letter g
Center C

Tools Menu Alt+l
Options O Yes
Shortcut Keys S Yes
Customize Toolbars Ctrl+Alt+C z Yes
Make Template From Document T Yes
Create Template Field C Yes
Find Duplicate Links F Yes
Remove Hypertext Links R



Remove HTML Tags H
Check HTML Syntax Ctrl+H e
Multi-File Find and Replace M Yes
Spell Check p
Real-time Output Viewer i
Convert to HTML n
Upload to Host U
Mixing Desk x

Window Menu Alt+W
Cascade C 
Tile T
Arrange Icons A
Close All l
Window List

Help Menu Alt+H
Contents C
Search S
HTML Reference H
Registering HotDog R
About HotDog A Yes
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Absolute and Relative File References

DESCRIPTION:
HotDog inserts links to graphics and local files in one of two ways using either Absolute or Relative 
references.      Both relative and absolute references should work properly on your machine. 

USAGE TIPS:
1  The main difference comes when you upload your document to the Internet. It's very unlikely that 
your Internet provider also keeps their images in a directory called C:\GRAPHICS\. And if they don't, 
then none of your absolute references will work. You'll have to change them all manually before 
uploading your documents to the Internet.

2    The easiest way to prevent problems is to keep all your images in the same directory as (or a 
subdirectory of) your HTML documents. That way, you can upload everything from a single location 
on your PC, to a single location on the Internet. You can move this directory somewhere else on your 
PC, and your HTML files will still work.

3    It also pays to save your HTML documents before inserting any images. That way HotDog knows 
where to look for relative references - it doesn't just assume the Documents directory or the HotDog 
directory.

4  If you have not saved the current document, then relative references will be based on the 
Documents directory. If no Documents directory is defined, they will be based on the HotDog 
directory (wherever HOTDOG.EXE is).



Document Bar

DESCRIPTION:
The Document Bar provides a convenient way to switch between the documents you are currently 
editing, and to check at a glance if you have saved your work.

FEATURE:
1  If you look slightly to the right of centre on the Document bar you will find the current system time.
2    If you look to the further right from the time you can find the current line number your cursor is 

on.
3    The tabs that appear on the Document bar show currently used files.    The filename is also 

shown.
4    If you are using the Floating toolbars when you place your cursor on the tool it’s name appears 

on the far left of the Document bar.

USAGE TIPS:
1    To switch to another document, click the tab containing its name. This has the same effect as 

choosing the document name from the Window List.

2    Documents that have not changed since the last time they were saved are indicated with the 

 icon next to their name. Unsaved documents are marked with a 



Hypertext Links

DESCRIPTION:
Hypertext links let you define a section of text that can be clicked by the user. When they click this text, 
they will go to another document, download a file, listen to a sound, or perhaps go to an Internet service 
like a WAIS database.

Hypertext links are defined with the <A> Anchor element. Each anchor specifies the address of the 
document it goes to, with the HREF property. Anchors can be images or text, or a combination of the two. 
For example,

image only

About HotDog text only

About HotDog image and text

Relative vs Absolute References
Documents on the same system are usually inserted as relative addresses.    For example, let's say 
that your Internet account has the following directories:

public_html for document files
public_html/graphics for images

If all your documents are in public_html, you do not have to specify a URL for each one. Instead of 
<A HREF="http://www.sausage.com/intro.html"> Sausage Software </A>

you can use
<A HREF="intro.html"> Sausage Software </A>



This works as long as there is a document called intro.html in the same directory as the current 
document. 

Directories can be absolute as well. For example, we could use a picture for the above hypertext 
link:

<A HREF="http://www.sausage.com/graphics/HotDog.gif"> Sausage Software </A>
or

<A HREF="graphics/HotDog.gif"> Sausage Software </A>

This works as long as the current directory has a sub-directory called graphics.



Report On Project

DESCRIPTION:
If you are using a Web Project, making a Report on a Project will create a summary report of all the 
images and links contained in the projects files. One potential use of this information is to make sure 
you upload all the necessary files to your web server.    The report will be stored in a text file, and 
when the report has been written, HotDog will ask you if you want to view it.

USAGE TIPS:
Web Projects are a convenient way to deal with multiple files at the same time. For example, you can 
create a project containing five related HTML documents. Every time you open the project, all five 
documents will be loaded into HotDog for editing. Using a project means that you only need to open 
one file (the .PRJ project file) instead of the five individual documents.



Save Project

DESCRIPTION:
Save Project,    lets you save an existing Web Project that you’ve previously created. It’s a    convenient 
way to deal with multiple files at the same time. 

USAGE TIPS:
For example, you can create a project containing five related HTML documents. Every time you open the 
project, all five documents will be loaded into HotDog for editing. Using a project means that you only 
need to open one file (the .PRJ project file) instead of the five individual documents.



Web Projects

DESCRIPTION:
Using a Project to manipulate files is one of our most frequently requested features.    By opening a 
Project, it allows you to combine multiple files so you can open,    save even get a report with the a 
single mouse click.      You’ll be amazed by how much time this can save!        If you want to Add, 
delete or modify the files in the project you can use the Project Manager.

USAGE TIPS:
Creating a project involves doing the following,

· Go and Open the Project 
· Make sure you fill out the Project details in the Project window
· Open all the documents you want contained in the project.
· Choose Save Project from   File ProjectManager  .
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Characters 

Here are some in depth discussions on what you may want to know about “characters”.
· Character data
· Control characters
· Special characters
· Character entity references
· Table of ISO 8870:1986//ENTITIES



Character Data

DISCUSSION
The characters between HTML elements represent text. A HTML document (including elements and text) 
is encoded using the coded character set specified by the "charset" parameter of the "text/html" media 
type.    For levels defined in this specification, the "charset" parameter is restricted to "US-ASCII" or 
"ISO-8859-1". ISO-8859-1 encodes a set of characters known as Latin Alphabet No. 1, or simply Latin-1. 

Latin-1 includes characters from most Western European languages, as well as a number of control 
characters.    Latin-1 also includes a non-breaking space, a soft hyphen indicator, 93 graphical 
characters, 8 unassigned characters, and 25 control characters.

Take note
· Because non-breaking space and soft hyphen indicator are not recognized and interpreted 

by all HTML user agents, their use is discouraged.

· There are 58 character positions occupied by control characters. See Control Characters 
for details on the interpretation of control characters.

· Because certain special characters are subject to interpretation and special processing, 
information providers and HTML user agent implementors should follow the guidelines in 
the Special Characters section.

· In addition, HTML provides character entity references and numerical character 
references to facilitate the entry and interpretation of characters by name and by numerical 
position.

· Because certain characters will be interpreted as markup, they must be represented by 
entity references as described in character and/or numerical references.



Control Characters

DISCUSSION
Control characters are non-printable characters that are typically used for communication and device 
control, as format effectors, and as information separators.

In SGML applications, the use of control characters is limited in order to maximize the chance of 
successful interchange over heterogenous networks and operating systems. In HTML, only three control 
characters are used: Horizontal Tab (HT, encoded as 9 decimal in US-ASCII and ISO-8859-1), Carriage 
Return, and Line Feed.

Horizontal Tab is interpreted as a word space in all contexts except preformatted text. Within 
preformatted text, the tab should be interpreted to shift the horizontal column position to the next 
position which is a multiple of 8 on the same line; that is, col := (col+8) mod 8.

Carriage Return and Line Feed are conventionally used to represent end of line. For Internet Media 
Types defined as "text/*", the sequence CR LF is used to represent an end of line. In practice, 
text/html documents are frequently represented and transmitted using an end of line convention that 
depends on the conventions of the source of the document; frequently, that representation consists of 
CR only, LF only, or CR LF combination. In HTML, end of line in any of its variations is interpreted as 
a word space in all contexts except preformatted text. Within preformatted text, HTML interpreting 
agents should expect to treat any of the three common representations of end-of-line as starting a 
new line.



Special Characters discussion

DISCUSSION
Certain characters have special meaning in HTML documents.    There are two printing characters 
which may be interpreted by an HTML application to have an effect of the format of the text:

Space
· Interpreted as a word space (place where a line can be broken) in all contexts except the 

Preformatted Text element.
· Interpreted as a nonbreaking space within the Preformatted Text element.

Hyphen
· Interpreted as a hyphen glyph in all contexts
· Interpreted as a potential word space by hyphenation engine

The following entity names are used in HTML, always prefixed by ampersand (&) and followed by a 
semicolon. They represent particular graphic characters which have special meanings in places in 
the markup, or may not be part of the character set available to the writer.

The following table lists each of the supported characters specified in the Numeric and Special 
Graphic entity set, along with its name, syntax for use, and description. This list is derived from ISO 
Standard 8879:1986//ENTITIES,     Numeric and Special Graphic//EN however HTML does not 
provide support for the entire entity set. Only the entities listed below are supported.

Glyph Name Syntax Description
    < lt &lt Less than sign
> gt &gt Greater than sign
&amp &amp Ampersand
" quot &quot Double quote sign



Character Entity References

DISCUSSION
Many of the Latin alphabet No. 1 set of printing characters may be represented within the text of an HTML 
document by a character entity.

Two reasons for using a character entity:
· the keyboard does not provide a key for the character, such as on U.S. keyboards which do 

not provide European characters
· the character may be interpreted as SGML coding, such as the ampersand (&), double 

quotes ("), the lesser (<) and greater (>) characters

A character entity is represented in an HTML document as an SGML entity whose name is defined in 
the HTML DTD. The HTML DTD includes a character entity for each of the SGML markup characters 
and for each of the printing characters in the upper half of Latin-1, so that one may reference them by 
name if it is inconvenient to enter them directly:

· the ampersand (&amp;), 
· double quotes (&quot;), 
· lesser (&lt;) and greater (&gt;) characters

“Kurt G&ouml;del was a famous logician and mathematician.”

Take Note:
· To ensure that a string of characters is not interpreted as markup, represent all occurrences 

of <, >, and & by character or entity references.

· There are SGML features, CDATA and RCDATA, to allow most <, >, and & characters to be 
entered without the use of entity or character references. Because these features tend to 
be used and implemented inconsistently, and because they require 8-bit characters to 
represent non-ASCII characters, they are not used in this version of the HTML DTD. An 
earlier HTML specification included an Example element (<XMP>) whose syntax is not 
expressible in SGML. No markup was recognized inside of the Example element except the 
</XMP> end element. While HTML user agents are encouraged to support this idiom, its 
use is deprecated.

· The following entity names are used in HTML, always prefixed by ampersand (&) and 
followed by a semicolon.    The following table lists each of the characters specified in the 
Added Latin 1 entity set, along with its name, syntax for use, and description. This list is 
derived from ISO Standard 8879:1986//ENTITIES Added Latin 1//EN. HTML supports the 
entire entity set.



Table of ISO 8870:1986//ENTITIES

DISCUSSION
List derived from ISO Standard 8879:1968//ENTITIES
The last three character entities are only supported in recent versions of Mosaic and Netscape .    
They may not appear as planned in early versions of these, or different browsers.

Name Syntax Description
Aacute &Aacute Capital A, acute accent
Agrave &Agrave Capital A, grave accent
Acirc &Acirc Capital A, circumflex accent
Atilde &Atilde Capital A, tilde
Aring &Aring Capital A, ring
Auml &Auml Capital A, dieresis or umlaut mark
AElig &Aelig Capital AE dipthong (ligature)
Ccedil &Ccedil Capital C, cedilla
Eacute &Eacute Capital E, acute accent
Egrave &Egrave Capital E, grave accent
Ecirc &Ecirc Capital E, circumflex accent
Euml &Euml Capital E, dieresis or umlaut mark
Iacute &Iacute Capital I, acute accent
Igrave &Igrave Capital I, grave accent
Icirc &Icirc Capital I, circumflex accent
Iuml &Iuml Capital I, dieresis or umlaut mark
ETH &ETH Capital Eth, Icelandic
Ntilde &Ntilde Capital N, tilde
Oacute &Oacute Capital O, acute accent
Ograve &Ograve Capital O, grave accent
Ocirc &Ocirc Capital O, circumflex accent
Otilde &Otilde Capital O, tilde
Ouml &Ouml Capital O, dieresis or umlaut mark
Oslash &Oslash Capital O, slash
Uacute &Uacute Capital U, acute accent
Ugrave &Ugrave Capital U, grave accent
Ucirc &Ucirc Capital U, circumflex accent
Uuml &Uuml Capital U, dieresis or umlaut mark;
Yacute &Yacute Capital Y, acute accent
THORN &THORN Capital THORN, Icelandic
Szlig &szlig Small sharp s, German (sz ligature)
aacute &aacute Small a, acute accent
agrave &agrave Small a, grave accent



acirc &acirc Small a, circumflex accent
atilde &atilde Small a, tilde
aring &aring Small a, ring
auml &auml Small a, dieresis or umlaut mark
aelig &aelig Small ae dipthong (ligature
ccedil &ccedil Small c, cedilla
eacute &eacute Small e, acute accent
egrave &egrave Small e, grave accent
ecirc &ecirc Small e, circumflex accent
euml &euml Small e, dieresis or umlaut mark
iacute &iacute Small i, acute accent
igrave &igrave Small i, grave accent
icirc &icirc Small i, circumflex accent
iuml &iuml Small i, dieresis or umlaut mark
eth &eth Small eth, Icelandic
ntilde &ntilde Small n, tilde
oacute &oacute Small o, acute accent
ograve &ograve Small o, grave accent
ocirc &ocirc Small o, circumflex accent
otilde &otilde Small o, tilde
ouml &ouml Small o, dieresis or umlaut mark
oslash &oslash Small o, slash
uacute &uacute Small u, acute accent
ugrave &ugrave Small u, grave accent
ucirc &ucirc Small u, circumflex accent
uuml &uuml Small u, dieresis or umlaut mark
yacute &yacute Small y, acute accent
thorn &thorn Small thorn, Icelandic
yuml &yuml Small y, dieresis or umlaut mark
reg &reg Registered TradeMark
copy &copy Copyright
trade &trade TradeMark






